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People

g Stella Lee

=) Virgil Scott

See the location of a friend

In the People list, tap the person you want to locate.
e If your friend can be located: They appear on a map so you can see where they are.
o If your friend can’t be located: You see “No location found"” under their name.

e If you aren’t following your friend: You see "Can see your location” under their name. Ask to follow
a friend to see their location.

You can also ask Siri to locate a friend who has shared their location with you.

@ Ask Siri. Say something like: “Where's Gordon?” Learn how to ask Siri .

Contact a friend

1. In the People list, tap the name of the person you want to contact.

2. Tap Contact and choose how you want to contact your friend. See Add and use contact
information on iPhone .

Get directions to a friend
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You can get directions to a friend’s current location in the Maps app.
1. In the People list, tap the name of the person you want to get directions to.
2. Tap Directions to open Maps.

3. Tap the route to get directions from your current location to your friend's location. See Follow
turn-by-turn directions in Maps on iPhone .

Set a label for a friend's location

You can set a label for a friend’s current location to make it more meaningful (like Home or Work). The
label appears below your friend's name when they're at that location.

1. In the People list, tap the name of the person you want to set a location label for.
2. Tap Edit Location Name, then select a label.

To add a new label, tap Add Custom Label, enter a name, then tap Done.

Mark favorite friends

Favorite friends appear at the top of the People list and are marked by a star.
1. In the People list, find the person you want to mark as a favorite.
2. Do one of the following:

e Tap the name of the person, then tap Add [name ] to Favorites.

e Swipe left across the person’s name, then tap the star.

To remove a friend from your Favorites, swipe left and tap the star, or tap the friend, then tap Remove
[name ] from Favorites.

Set location notifications for friends in Find My on iPhone

Use the Find My app @ to let a friend know when your location changes. You can also get a
notification when your friend's location changes.

Notify a friend when your location changes

1. In the People list, tap the name of the person you want to notify.
2. Under Notifications, tap Add, then tap Notify [your friend’s name ].

3. Choose whether you want to notify your friend when you arrive at or leave a location.
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4. Choose a location, or tap Add Location to create a new location and set a location radius.

With a larger radius, your friend is notified when you're close to the location instead of right at the
location.

5. Choose whether you want your friend to be notified only once or every time.

6. Tap Add.

Get notified when your friend's location changes

1. In the People list, tap the name of the person you want to be notified about.

2. Under Notifications, tap Add, then tap Notify Me.

3. Choose whether you want to be notified when a friend arrives at or leaves a location.

4. Choose a location, or tap Add Location to create a new location and set a location radius.

With a larger radius, you're notified when your friend is close to the location instead of right at the
location.

5. Tap Add, then tap Create Notification.
Your friend gets an alert after you set the notification.

You can set up to 25 Notify Me notifications across all your friends.

See all notifications about you
1. Tap Me.

Under Notifications About You, you see a list of people who are notified when your location
changes.

2. Select a name to see more details.

To turn off a notification, tap the notification, tap Delete Notification, then tap Delete Notification
again.

Change or turn off a notification you set

1. In the People list, tap the name of the person whose notification you want to change or turn off.

This could be a notification you receive about a friend, or a notification your friend receives about
you.

2. Under Notifications, tap the notification.
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3. Do either of the following:
e Change a notification: Change any details, then tap Done.

e Turn off a notification: Tap Delete Notification, then tap Delete Notification again.

Choose who you receive location updates from

You can choose whether you want to receive location notifications from everyone or only from friends
you share your location with.

1. Tap Me, then tap Receive Location Updates.

2. Select People You Share With or Everyone.

Find devices

Add or remove a device in Find My on iPhone

Before you can use the Find My app @ to locate a lost iPhone, iPad, iPod touch, Apple Watch, or
AirPods, you need to add them to Find My.

For your iPhone, iPad, iPod touch, Mac (with macOS Catalina), and Apple Watch, Find My also
includes a feature called Activation Lock that prevents anyone else from activating and using your
device, even if it's completely erased. See the Apple Support articles Activation Lock for iPhone, iPad,
and iPod touch , About Activation Lock on your Mac , and About Activation Lock on your Apple Watch

Add an iPhone, iPad, or iPod touch

For a device with iOS 13, iPadOS 13, or later, follow the instructions below. For a device with iOS 12 or
earlier, see the Apple Support article Set up Find My iPhone on all of your devices .

1. Onyour iPhone, iPad, or iPod touch, go to Settings @ > [your name ] > Find My.

If you're asked to sign in, enter your Apple ID . If you don’t have one, tap “Don’t have an Apple ID
or forgot it?"” then follow the instructions.

2. Tap Find My [device ], then turn on Find My [device ].
3. Turn on any of the following:

e Enable Offline Finding: When your device isn’t connected to Wi-Fi or cellular, Find My can
locate it using Bluetooth.

e Send Last Location: If your device's battery charge level becomes critically low, its location is
sent to Apple automatically.
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Add a Mac
1. On your Mac, choose Apple menu & > System Preferences.
2. Do one of the following:
e With macOS Catalina: Click Apple ID, then click iCloud.
e With macOS 10.14 or earlier: Click iCloud.

If you're asked to sign in, enter your Apple ID . If you don’t have one, click “Don’t have an Apple ID
or forgot it?"” then follow the instructions.

3. Select Find My Mac, then click Allow.

When you select Find My Mac on a Mac with macOS Catalina, Offline Finding is turned on. Offline
Finding allows your Mac to be located using Bluetooth when your Mac isn’t connected to Wi-Fi. To
turn off this option, click Options, then click Turn Off next to Offline Finding.

Add Apple Watch or AirPods

e Apple Watch: Pair your watch with an iPhone on which you're signed in with your Apple ID .

e AirPods: Pair your AirPods with an iPhone, iPad, or iPod touch on which you're signed in with your
Apple ID.

Add a family member's device

You can see your family members’ devices in Find My if you set up Family Sharing first. See Set up
Family Sharing on iPhone . Their devices appear below yours in the Devices list.

You can’t add friends' devices to Find My. Friends who lose a device can go to icloud.com/find and
sign in with their Apple ID.

Remove a device

When you remove a device, Activation Lock is turned off.

e Remove an iPhone, iPad, or iPod touch: On the device, go to Settings > [your name ] > Find My,
then turn off Find My [device ]. Enter your Apple ID password, then tap Turn Off. (On iOS 12 or
earlier, go to Settings > [your name ] > iCloud.)

¢ Remove a Mac: On the Mac, choose Apple menu @& > System Preferences. Click Apple ID, click
iCloud (or just click iCloud on macOS 10.14 or earlier), then deselect Find My Mac. Enter your
Apple ID password, then click Continue.

iPhone User Guide 181



Draft

e Remove an Apple Watch or AirPods: Turn off Apple Watch or put AirPods in their case. Then, in

Find My on your iPhone, select the offline device and tap Remove This Device, then tap Remove.

To prevent an Apple Watch or AirPods from reappearing, unpair them in Bluetooth Settings on all
your devices.

Note: You can also remove your iPhone, iPad, iPod touch, or Mac by signing out completely on that
device in Settings or System Preferences. Signing out turns off all iCloud features on the device. See
the Apple Support article Sign out of iCloud on your iPhone, iPad, iPod touch, Apple TV, or Mac .

Remove a device you no longer have

If you no longer have a device because you gave it away or sold it, you need to remotely erase it
before you can remove it.

1.

2.

In the Devices list, tap the device you want to remove.
Erase the device .
Because the device isn't lost, don’t enter a phone number or message.

If the device is offline, the remote erase begins the next time it connects to a Wi-Fi or cellular
network. You receive an email when the device is erased.

When the device is erased, tap Remove This Device, then tap Remove.

All your content is erased, Activation Lock is turned off, and someone else can now activate the
device.

Locate a device in Find My on iPhone

Use the Find My app @ to locate and play a sound on a missing iPhone, iPad, iPod touch, Mac, Apple
Watch, or AirPods. In order to locate a device, you must turn on Find My [device] before it's lost.

If you lose your iPhone and don’t have access to the Find My app, you can locate or play a sound on
your device using Find My iPhone on iCloud.com .
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Devices

John's iPad

iPod touch

John's iPhone

See the location of a device

In the Devices list, tap the device you want to locate.
o If the device can be located: It appears on the map so you can see where it is.

e [f the device can’t be located: You see “No location found” under the device’s name. Under
Notifications, turn on Notify When Found. You receive a notification once it's located.

Play a sound on your iPhone, iPad, iPod touch, Mac, or Apple Watch

1. In the Devices list, tap the device you want to play a sound on.
2. Tap Play Sound.

e |f the device is online: A sound starts after a short delay and gradually increases in volume,
then plays for about two minutes. The device vibrates (if applicable). A Find My [device ] alert
also appears on the device's screen.

A confirmation email is also sent to your Apple ID email address.

e [f the device is offline: You see Pending under Play Sound. The sound plays the next time it
connects to a Wi-Fi or cellular network.
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@ Ask Siri. Say something like: “Help me find my iPad” or “Play a sound on my iPod touch.” Learn
how to ask Siri .

Play a sound on your AirPods

1. In the Devices list, tap the AirPods you want to play a sound on.

2. Tap Play Sound. If your AirPods are separated, you can mute one by tapping Left or Right to find
them one at a time.

e [f your AirPods are online: They play a sound immediately (for two minutes).
A confirmation email is also sent to your Apple ID email address.

o [f your AirPods are offline: You receive a notification the next time your AirPods are in range of
your iPhone, iPad, or iPod touch.

Stop playing a sound on a device

If you find your device and want to turn off the sound before it stops automatically, do one of the
following:

e jPhone, iPad, or iPod touch: Press the power button or a volume button, or flip the Ring/Silent
switch. If the device is locked, you can also unlock it, or swipe to dismiss the Find My [device ]
alert. If the device is unlocked, you can also tap OK in the Find My [device ] alert.

e Apple Watch: Tap Dismiss in the Find My Watch alert, or press the Digital Crown or side button.
¢ Mac: Click OK in the Find My Mac alert.

e AirPods: Put your AirPods in their case and close the lid, or tap Stop in Find My.

Get directions to a device

You can get directions to a device's current location in the Maps app.
1. In the Devices list, tap the device you want to get directions to.
2. Tap Directions to open Maps.

3. Tap the route to get directions from your current location to the device's location. See Follow
turn-by-turn directions in Maps on iPhone .

Locate or play a sound on a friend's device

If your friend loses a device, they can locate it or play a sound on it by going to icloud.com/find and
signing in with their Apple ID and password.
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To learn more, see Locate a device in Find My iPhone on iCloud.com in the iCloud User Guide.

Mark a device as lost in Find My on iPhone

Use the Find My app @ to mark a missing iPhone, iPad, iPod touch, Apple Watch, or Mac as lost so
that others can’t access your personal information. In order to mark a device as lost, you must turn on
Find My [device] before it's lost.

Lost iPhone
This iPhone has been lost.

Please call me. Add a custom

(669) 555-3691 message with your
phone number.

What happens when you mark a device as lost?

¢ A confirmation email is sent to your Apple ID email address.

¢ You can display a custom message on the screen. For example, you may want to indicate that the
device is lost or how to contact you.

e Your device doesn’'t display alerts or make noise when you receive messages or notifications, or if
any alarms go off. Your device can still receive phone calls and FaceTime calls.

e Apple Pay is disabled for your device. Any credit or debit cards set up for Apple Pay, student ID
cards, and Express Transit cards are removed from your device. Credit, debit, and student ID
cards are removed even if your device is offline. Express Transit cards are removed the next time
your device goes online. See the Apple Support article Manage the cards that you use with Apple
Pay .
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e For aniPhone, iPad, iPod touch, or Apple Watch, you see your device's current location on the
map as well as any changes in its location.

Mark a device as lost

If your device is lost or stolen, you can turn on Lost Mode for your iPhone, iPad, iPod touch, or Apple
Watch, or lock your Mac.

1. In the Devices list, tap the lost device.
2. Under Mark As Lost, tap Activate.
3. Follow the onscreen instructions, keeping the following in mind:

e Passcode: If your iPhone, iPad, iPod touch, or Apple Watch doesn’t have a passcode, you're
asked to create one now. For a Mac, you must create a numerical passcode, even if you
already have a password set up on your Mac. This passcode is distinct from your password
and is only used when you mark your device as lost.

e Contact Information: If you're asked to enter a phone number, enter a number where you can
be reached. If you're asked to enter a message, you may want to indicate that the device is lost
or how to contact you. The number and message appear on the device’s Lock screen.

4. Tap Activate (for an iPhone, iPad, iPod touch, or Apple Watch) or Lock (for a Mac).

When the device has been marked as lost, you see Activated under the Mark As Lost section. If the
device isn't connected to a Wi-Fi or cellular network when you mark it as lost, you see Pending until
the device goes online again.

Change contact information or email notifications for a lost device

After you mark your iPhone, iPad, iPod touch, or Apple Watch as lost, you can update your contact
information or email notification settings.

1. In the Devices list, tap the lost device.
2. Under Mark As Lost, tap Pending or Activated.
3. Do any of the following:
e Change contact information: Make any changes.
o Get email updates: Turn on Receive Email Updates if it's not already on.

4. Tap Done.

Turn off Lost Mode for an iPhone, iPad, iPod touch, or Apple Watch

When you find your lost device, do either of the following to turn off Lost Mode:
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Enter your passcode on the device.

In Find My, tap the device, tap Pending or Activated under Mark as Lost, tap Turn Off Mark As
Lost, then tap Turn Off.

Unlock a Mac

When you find your lost Mac, enter the numeric passcode on the device to unlock it (the one you set
up when you marked your Mac as lost).

If you forget your passcode, you can recover it using Find My iPhone on iCloud.com . For more
information, see Use Lost Mode in Find My iPhone on iCloud.com in the iCloud User Guide.

If you lose your iPhone, you can turn on Lost Mode using Find My iPhone on iCloud.com .

Erase a device in Find My on iPhone

Use the Find My app @ to erase an iPhone, iPad, iPod touch, Apple Watch, or Mac. In order to
remotely erase a device, you must turn on Find My [device] before it's lost.

What happens when you erase a device in Find My?

A confirmation email is sent to your Apple ID email address.

When you erase a device remotely using Find My, Activation Lock remains on to protect it. Your
Apple ID and password are required to reactivate it.

After you erase a device, you can’t use Find My to locate the device or play a sound on it.
However, you may still be able to locate your Mac or Apple Watch if it's near a previously used Wi-
Fi network.

Apple Pay is disabled for your device. Any credit or debit cards set up for Apple Pay, student ID
cards, and Express Transit cards are removed from your device. Credit, debit, and student ID
cards are removed even if your device is offline. Express Transit cards are removed the next time
your device goes online. See the Apple Support article Manage the cards that you use with Apple
Pay .

Erase a device

1.

In the Devices list, tap the device you want to erase.

2. Tap Erase This Device, then tap Erase This [device ].

If the device is a Mac, enter a passcode to lock it (you need to use the passcode to unlock it).
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3. If the device is lost and you're asked to enter a phone number or message, you may want to
indicate that the device is lost or how to contact you. The number and message appear on the
device's Lock screen.

4. Tap Erase.
5. Enter your Apple ID password, then tap Erase again.

If your device is offline, the remote erase begins the next time it connects to a Wi-Fi or cellular
network.

Cancel an erase
If you erase an offline device and find it before it comes online again, you can cancel the erase
request.

1. In the Devices list, tap the device whose erase you want to cancel.

2. Tap Cancel Erase, then enter your Apple ID password.

If you lose your iPhone, you can erase it using Find My iPhone on iCloud.com .

Find My

Adjust map settings in Find My on iPhone

In the Find My app @ , you can change the map view or distance units.

Note: These settings only affect maps in the Find My app on the device. They don't affect maps in
other apps or on other devices.

Change map view
1. Tap @ in the top-right corner of the map.

2. Under Map View, select Map, Hybrid, or Satellite.

Change distance units
1. Tap @ in the top-right corner of the map.

2. Under Distance, select Miles or Kilometers.
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Health

Collect health and fitness data on iPhone

The Health app ® can track your daily footsteps and the flights of stairs you climb. You can manually
add other data like body weight and caffeine intake, and track additional data with other apps (such
as nutrition and fitness apps) and devices that are compatible with Health (such as Apple Watch,
AirPods, weight scales, and blood pressure monitors).

Summary ©

@ Sound levels hit 80 decibels.

86
..oo|' "
LA J

80 d8
LK

Favorites

& Activity

Move

Manually update your health profile

When you first open Health, you're asked to set up a health profile with basic information such as
your date of birth and sex. If you don’t supply all of the requested information, you can update your
profile later.

1. Tap your profile picture at the top right of the Summary screen.

If you don’t see your profile picture, tap Summary at the lower left.
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2. Tap Health Profile, then tap Edit.

< Back Health Profile

First Name Karina
Last Name Cavanna
Date of Birth Feb 10, 1985 (34)
Sex Female
Blood Type O+
Fitzpatrick Skin Type Type lll

Wheelchair

3. Tap afield, make a change, then tap Done.

Manually add data to a health category

1. Tap Browse at the bottom right to display the Health Categories screen, then do one of the
following:

e Tap a category. (To see all categories, scroll down.)

e Tap the search field, then type the name of a category (such as body measurements) or a
specific type of data (such as weight).

If you don't see the Health Categories screen, tap Browse again at the bottom right.
2. Tap > for the data you want to update.
3. Tap Add Data at the top-right corner of the screen.

4. Add your information, then tap Add or Done in the top-right corner of the screen.

Collect data from other sources
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e From Apple Watch: After you pair iPhone with Apple Watch , a periodic heart rate measurement is
automatically sent from Apple Watch to Health. You can also set up Apple Watch to send activity
metrics, noise levels, and more to Health. See the Apple Watch User Guide .

e From headphones: After you connect EarPods, AirPods, and other compatible headphones to your
iPhone, the headphones’ audio levels are automatically sent to Health.

e From an app that you download from the App Store: As you set up the app, you can allow it to
share data with Health.

e From another device: Follow the setup instructions for the device.

If it's a Bluetooth device, you need to pair it with iPhone. Follow the instructions that came with
the device to put it in discovery mode, go to Settings @ > Bluetooth, turn on Bluetooth, then tap
the name of the device.

WARNING: iPhone and Apple Watch aren’t medical devices. See Important safety information for
iPhone .

View health and fitness information on iPhone

In the Health app | ® , find health and fitness information about yourself in one place.

View your highlights

Tap Summary at the lower left, then scroll down to see highlights of your recent health and fitness
data.

To see more details about a category, tap > .
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Summary

Highlights

& Workouts

Your average pace during your last run
was 10 minutes, 44 seconds per mile.

5S¢ 1 550kcal

O Steps

You walked an average of 9,445 steps
a day over the last 7 days.

Add or remove a health category from Favorites on the Summary screen

Tap Summary at the lower left, tap Edit for the Favorites section, tap a category to turn it on or off,
then tap Done.

View details in the health categories

Tap Browse at the bottom right to display the Health Categories screen, then do one of the following:
e Tap a category. (To see all categories, scroll up and down.)

e Tap the search field, then type the name of a category (such as Nutrition) or a specific type of
data (such as Protein).
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6of 7 days

Gof 7 days

Highlights
& Activity

You've closed all your rings 1time
this week.

4

To view details about any of the data, tap > . Depending on the data type, you may be able to do the
following:

e See weekly, monthly, and yearly views of the data: Tap the tabs at the top of the screen.
e Manually enter data: Tap Add Data in the top-right corner of the screen.

e Move a data type to Favorites on the Summary screen: Turn on Add to Favorites. (Scroll down if
you don't see Add to Favorites.)

o View which apps and devices are allowed to share data: Tap Data Sources & Access below
Options. (Scroll down if you don’t see Options.)

e Delete data: Tap Show All Data below Options, swipe left on a data record, then tap Delete. To
delete all data, tap Edit, then tap Delete All.

e Change the measurement unit: Tap Unit below Options, then select a different unit.

Learn more about health and fithess

The bottom of the Summary screen provides introductory articles, app suggestions, and other
information. Tap an item to learn more.

When you view health category details, many categories also show recommended apps.
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Track your menstrual cycle on iPhone

In the Health app | ® , track your menstrual cycle to get period and fertility window predictions.

Get started with cycle tracking
1. Tap Browse at the bottom right, then tap Cycle Tracking.

2. Tap Get Started, then follow the onscreen instructions.

To help improve predictions for your period and fertility window, enter the requested information
about your last period.

Log your cycle information
1. Tap Browse at the bottom right, then tap Cycle Tracking.

2. Do any of the following:

e Log a period day: Tap a day in the timeline at the top of the screen. To log the flow level for
that day, tap Period below Cycle Log, then choose an option.

Or tap Add Period at the top right, then select days from the monthly calendar.
Logged days are marked on the timeline with solid red circles. To remove a logged day, tap it.

e Log symptoms: Drag the timeline at the top of the screen to select a day, tap Symptoms, then
select all that apply. When finished, tap Done. Days with symptoms are represented by purple
dots.

e Log spotting: Drag the timeline to select a day, tap Spotting, choose Had Spotting, then tap
Done.

3. To add additional categories, such as ovulation test results and basal body temperature, tap
Options, then choose the categories.

iPhone User Guide 194



Draft

94 ol T -

< Back Cycle Tracking  Add Perioc

Today, September 10

v

Cycle Log

Period

* OTHER DATA
Symptoms
Sexual Activity
Ovulation Test Result
Cervical Mucus Quality
Basal Body Temperature

Spotting

View the cycle timeline
Tap Browse at the bottom right, then tap Cycle Tracking.

Timeline information is displayed in the following format:

Solid red circles: Days you logged for your period.

Purple dots: Days you logged for having symptoms.

Light red circles: Your period prediction.

To hide or show predicted period days, tap Options, then turn Period Prediction off or on.

Light blue days: A prediction of your likely fertility window. Fertility window predictions should not
be used as a form of birth control.

To show or hide the fertile window prediction, tap Options, then turn Fertility Prediction on or off.

To select different days, drag the timeline. Data that you logged for the selected day appears below
in the Cycle Log.

Change period and fertility notifications and other cycle tracking options
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1. Tap Browse at the bottom right, then tap Cycle Tracking.
2. Scroll down, then tap Options.

3. To turn an option on or off, tap it.

View your cycle history and statistics
1. Tap Browse at the bottom right, then tap Cycle Tracking.

2. Scroll down to see timelines of your three most recent periods; scroll further to see related
statistics.

3. To see more details and older information for Cycle History or Statistics, tap > in that portion of
the screen.

To find only the days that match a particular symptom or flow level in the detailed Cycle History,
tap Filters at the top right, choose an option, then tap Done.

Monitor audio levels on iPhone

Use the Health app ' to monitor audio levels from headphones and sound levels from your
environment. It can be helpful to understand how long and often you're exposed to loud volume as it
can affect your hearing.

View audio levels

After you connect EarPods, AirPods, and other compatible headphones to your iPhone, the audio
levels are automatically sent to Health.

After you pair Apple Watch with your iPhone, and set up the Noise app on Apple Watch (watchOS 6
required), environmental sound levels are automatically sent from Apple Watch to Health. See the
Apple Watch User Guide .

Note: Measurements are more accurate from AirPods than from headphones connected by wire.
Measurements for wired headphones are estimated based on the volume of your iPhone.

1. Tap Browse at the bottom right, then tap Hearing.
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2. Tap Headphone Audio Levels or Environmental Sound Levels, then do any of the following:
e [earn about the sound level classifications: Tap @ .
e View exposure levels over a time period: Tap the tabs at the top of the screen.
All levels are measured in decibels.
e Change the time span displayed in the graph: Swipe the graph left or right.

e See details about a moment in time: Touch and hold the graph, then drag to move the
selection.

e View details about average exposure: Tap Show All Filters, then tap Daily Average.
e View a line representing average exposure: Tap Exposure below the graph.
e View the high and low range: Tap Show All Filters, then tap Range.

e Filter the data by headphones: Tap Show All Filters, scroll to the bottom of the screen, then
choose one of your headphones.

e View highlights: Scroll down; to see more, tap Show All.

View noise notifications for environmental sounds

Sounds are generally considered loud when they're over 80 decibels. You can get a notification from
Apple Watch when sound reaches a level that might affect your hearing.

1. Tap Browse at the bottom right, then tap Hearing.

2. Tap Noise Notifications, then tap a notification to see more details.

Share health and fithess data on iPhone

You can give other apps permission to share health and fitness data with the Health app | * . For
example, if you install a workout app, its exercise data can appear in the Health app. The workout app
can also read and make use of data (such as your heart rate and weight) shared by other devices and

apps.

Control the sharing of data among apps and devices
1. Tap your profile picture at the top right.

If you don't see a profile picture, tap Summary or Browse at the bottom of the screen, then scroll
to the top of the screen.
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2. Below Privacy, tap Apps or Devices.
The screen lists the items that requested access to Health data.

3. To change the access for an item, tap it, then turn on or off permission to write data to—or read
data from—Health.

Export and share your health data
1. Tap your profile picture at the top right.

If you don't see a profile picture, tap Summary or Browse at the bottom of the screen, then scroll
to the top of the screen.

2. Tap Export all health data, then choose a method for sharing your data.

Your data is exported in XML format, a common format for sharing data between apps.

Download health records in Health on iPhone

The Health app ' ® offers access to information from supported health organizations about your
allergies, conditions, medications, and more (not available in all countries or regions).

Note: Your health organization might not appear in this feature. Organizations are added frequently.
See the Apple Support article Institutions that support health records on iPhone and iPod touch .
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Browse

Health Records

Allergies

Clinical Vitals

Conditions

Immunizations

Lab Results

Medications

Procedures

Widell Medical

4

When iPhone is locked with a passcode, Touch ID, or Face ID, all of the health data in the Health app
—other than what you add to your Medical ID —is encrypted.

Set up automatic downloads
1. Tap your profile picture at the top right, then tap Health Records.

If you don’t see a profile picture, tap Summary or Browse at the bottom of the screen, then scroll
to the top of the page.
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2. Do one of the following:
e Set up your first download: Tap Get Started.

e Set up downloads for additional accounts: Tap Add Account.

Health Records Close

Access Your Records
Connect to your provider to see your
health records and get updates when

there’s a new entry.

About Health Records & F

Get Started

3. Enter the name of an organization, such as a clinic or hospital, where you obtain your health
records. Or, to find a list of nearby organizations, enter the name of the city or state where you
live.

4. To open a result, tap it.

5. Below Available to Connect, tap the Connect to Account button to go to the sign-in screen for
your patient portal.

6. Enter the user name and password you use for the patient web portal of that organization, then
follow the onscreen instructions.

View your health records

Tap Browse at the bottom right to display the Health Categories screen, then do one of the following:

e Tap the search field, then enter the name of a health record category (such as Clinical Vitals) or a
type of data (such as Blood Pressure).
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¢ Scroll down, then tap a category (such as Allergies or Clinical Vitals) below Health Records.
e Scroll down, then tap the name of a specific organization.

To see more details, tap any section where you see > .

Widell Medical
September 10, 2019

ALLERGIES

LACTOSE

CONDITIONS

+/ Hypertension

IMMUNIZATIONS

/* Flu Vaccine

Influenza, seasonal, injectable,
preservative free
Administered

MEDICATIONS

Hydrochlorothiazide
Hydrochlorothiazide 26 MG

L 4

Customize notification settings for health records

Go to Settings @ > Notifications > Health, then choose options. See View and respond to notifications
on iPhone.

Delete an organization and its records from iPhone
1. Tap your profile picture at the top right, then tap Health Records.

If you don't see a profile picture, tap Summary or Browse at the bottom of the screen, then scroll
to the top of the page.

2. Tap the name of an organization, then tap Remove Account.
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Share your records with other apps

Third-party apps can request access to your health records. Before you grant access, be sure that
you trust the app with your records.

1. To grant access, choose which categories to share—such as allergies, medications, or
immunizations—when asked.

2. Choose whether to grant access to your current and future health records or to only your current
records.

If you choose to share only your current records, you're asked to grant access whenever new
records are downloaded to your iPhone.

To stop sharing health records with the app, turn off its permission to read data from Health.

Create a Medical ID in Health on iPhone

In the Health app [ ® , supply critical medical and contact information for first responders and others
who have physical access to your iPhone. They can tap Emergency, then tap Medical ID from the
Lock screen to view your Medical ID without entering a passcode.

Set up your Medical ID

1. Tap your profile picture at the top right.

If you don't see a profile picture, tap Summary or Browse at the bottom of the screen, then scroll
to the top of the screen.

2. Tap Medical ID, then tap Get Started.

Review or change your Medical ID
1. Tap your profile picture at the top right.

If you don't see a profile picture, tap Summary or Browse at the bottom of the screen, then scroll
to the top of the screen.

2. Tap Medical ID.

3. To make changes, tap Edit.
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£ Back %k Medical ID

Karina Cavanna
February 10, 1985 (34 years old)

Hypertension

Peanuts

Lisinopril (10mg by mouth once a day)

O+

Craig Rogers

Tip: You can quickly view your Medical ID from the Home screen. Touch and hold the Health app
icon, then choose Medical ID. See Perform quick actions from the Home screen .

Prevent viewing from the Lock screen
Tap your profile picture at the top right, tap Medical ID, tap Edit, then turn off Show When Locked.

If you don’t see a profile picture, tap Summary or Browse at the bottom of the screen, then scroll to
the top of the page.

View your Medical ID from the Lock screen

To see how your Medical ID appears to emergency responders, do any of the following:

e On an iPhone with Face ID: Press and hold the side button and either volume button until the
sliders appear, then drag the slider for Medical ID. When you're finished, tap Done. The next time
you unlock iPhone, your passcode is required to enable Face ID again.

e On an iPhone with a Home button: Wake iPhone and press the Home button (don’t use a finger
you have set up for Touch ID). On the Lock screen, tap Emergency, then tap Medical ID.
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Register as an organ donor in Health on iPhone

(U.S. only) In the Health app | * , register to be an organ, eye, or tissue donor with Donate Life
America. Your decision to donate is accessible to others in your Medical ID. (If you later change your
decision, you can remove your registration.)

Learn about organ donation
1. Tap your profile picture at the top right.

If you don’t see a profile picture, tap Summary or Browse at the bottom of the screen, then scroll
to the top of the page.

2. Tap Organ Donation, then tap Learn More for an overview of organ donation and Donate Life
America.

Register with Donate Life America
1. Tap your profile picture at the top right, then tap Organ Donation.

If you don’t see a profile picture, tap Summary or Browse at the bottom of the screen, then scroll
to the top of the page.

2. Tap Sign Up with Donate Life.

To later change your donor information or remove your registration, tap your profile picture, tap
Organ Donation, then tap Edit Donor Registration.

Back up your Health data on iPhone

If you sign in with your Apple ID , your health and fitness information in the Health app ' © is stored
automatically in iCloud. Your information is encrypted as it goes between iCloud and your device and
while it's stored in iCloud.

In addition to using iCloud, or if you aren’t using iCloud, you can back up your Health data by
encrypting a computer backup. See Back up iPhone .

Stop storing your Health data in iCloud

Go to Settings @ > [your name ] > iCloud, then turn off Health.
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Home

A look at Home on iPhone

The Home app ' provides a secure way to control and automate HomeKit-enabled accessories, such
as lights, locks, smart TVs, thermostats, window shades, smart plugs, and cameras. In iOS 13.2,
iPadOS 13.2, or later, you can also use Home to view and capture video from supported security
cameras. With Home, you can control any Works with Apple HomeKit accessory using iPhone.

Change home
settings.

me-‘\

Edit + Add an accessory
or scene.

My Home

Office lights on.
Kitchen door unlocked.
Details >

Favorite Scenes

Favorite Accessories

'f\
Kitchen Living Room Tap, or touch and

Fi Doot Light:
il v hold an accessory.

After you set up your home and its rooms, you can control accessories individually, or use scenes to
control multiple accessories with one command. For example, you might create a scene called “wake
up” that turns on lights in the kitchen, raises the thermostat, plays your morning playlist on the
kitchen HomePod, and unlocks the front door.

To control your home automatically and remotely, you must have Apple TV (4th generation or later),
HomePod, or iPad (with iOS 10.3, iPadOS 13, or later) that you leave at home. You can schedule
scenes to run automatically at certain times, or when you activate a particular accessory (for example,
when you unlock the front door). This also lets you, and others you invite, securely control your home
while you're away.
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Set up accessories with Home on iPhone

The first time you open the Home app ' , the setup assistant helps you create a home, where you
can add accessories and define rooms. If you've already created a home using another HomeKit-
enabled app, you'll skip this step.

Add an accessory to Home

Before you add an accessory such as a light or camera, be sure that it's connected to a power source,
is turned on, and is using your Wi-Fi network.

1. Tap the Home tab, then tap @ .
2. Tap Add Accessory, then follow the onscreen instructions.
When you add an accessory, it's assigned to a default room, or a room you choose.

You may need to scan a QR code or enter an 8-digit HomeKit setup code found on the accessory
itself (or its box or documentation). A supported smart TV displays a QR code for you to scan. You
can assign the accessory to a room, and give it a name, and then use this name when controlling the
accessory with Siri.

When you set up Apple TV in tvOS and assign it to a room, it automatically appears in that room in the
Home app on iPhone.

Assign a home accessory to a room

1. Tap Rooms, tap :=, then choose the room the accessory is currently assigned to.
If it's not already assigned, look in Default Room.

2. Touch and hold the accessory’s button, then swipe up on the screen or tap @ .

3. Tap Room, then choose a room.

4. Turn on Include in Favorites to add the accessory to the Home tab.

To rearrange your favorites, tap the Home tab, tap Edit, then drag the buttons into the
arrangement you want.

Organize rooms into zones

Group rooms together into a zone to easily control different areas of your home with Siri. For
example, if you have a two-story home, you can assign the rooms on the first floor to a downstairs
zone. Then you can say something to Siri like “Turn off the lights downstairs."

1. Tap Rooms, then tap i=.

iPhone User Guide 206



Draft

2. Tap Room Settings, then tap a room.

3. Tap Zone, then tap an existing zone, or tap Create New to add the room to a new zone.

Edit aroom

You can change a room's name and wallpaper, add the room to a zone, or remove the room. When
you remove the room, the accessories assigned to it move to Default Room.

1. Tap Rooms, then tap :=.

2. Tap Room Settings, then tap a room.

Control accessories with Home on iPhone

Use the Home app @1 to control accessories in your home.

Control an accessory

Tap the Home or Rooms tab, then tap the button for the accessory—a light, for example—to quickly
turn the accessory on or off, or touch and hold the button until controls appear.

The available controls depend on the type of accessory. For example, with some lightbulbs, there are
controls for changing colors. With your smart TV, you can choose an input source. You can also
control accessories using Control Center .

Edit home accessories

To edit accessory settings, touch and hold the accessory’s button, swipe up on the screen or tap @,
then do any of the following:

e Rename an accessory: Tap x to delete the old name, then type a new one.

e Change an accessory’s icon: Tap the icon next to the accessory’'s name, then select a new icon. If
you don't get a choice of other icons, it means the icon can’t be changed for this accessory.

Group accessories

You can control multiple accessories with the tap of a button by grouping them.

1. Touch and hold an accessory, swipe up on the screen or tap ¢, then tap Group with Other
Accessories.

2. Tap the accessory you want to group with this accessory—another light in the room, for example.
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3. In the Group Name field, type a name for the group.
4. Tap Done.

If you want the group to appear in the Home tab, turn on Include in Favorites.

Add more homes with iPhone

In the Home app © you can add more than one physical space—a home and a small office, for
example.

1. Tap the Home tab, then tap @ .
2. Tap Add Home, name the home, then tap Save.

3. To switch to another home, tap the Home tab, tap @& , then tap the home you want.

Set up HomePod in Home on iPhone

You can use the Home app © to add and edit alarms on HomePod and control many of its settings.

Use Home to add and edit HomePod alarms

In the Home app, touch and hold the HomePod button, swipe up or tap &, then tap Alarms and do
any of the following:

e Add an alarm: Tap -+, create the alarm, then tap Save.
e Edit an alarm: Tap Edit, tap the alarm time, change the time, then tap Save.
e Turn alarms on or off: Tap the switch next to an alarm.

e Delete an alarm: Tap Edit, tap @ next to the alarm, then tap Delete.

Change HomePod settings
1. In the Home app, touch and hold the HomePod button.

2. Swipe up on the screen or tap ; , then configure the HomePod settings.

You can assign HomePod to a different room, create a stereo pair with two HomePod speakers in
the same room, rename HomePod, turn on accessibility features, and more.

iPhone User Guide 208



Draft

Set up security cameras in Home on iPhone

In iOS 13.2 or later, you can use the Home app @1 to view video activity captured from your home's
security cameras when a person, animal, or vehicle is detected. The video captured by your cameras
is analyzed and encrypted on your home hub device (HomePod, Apple TV, or iPad) and securely
uploaded to iCloud so that only you and those you share it with can view it. See the Home accessories
website for a list of compatible security cameras.

With a 200-GB iCloud storage plan, you can view the last 10 days of activity from a single camera at
no additional cost. You can switch to a different camera at any time, but to stream and record from
more than one camera, you must have a 2-TB plan, which lets you view activity from up to five
cameras. Video content doesn’t count against your iCloud data limit.

Camera options

When you add a compatible camera to the Home app, you're asked to choose streaming and
recording options and assign the camera to a room. By default, the camera is marked as a favorite
and appears on the Home screen. To edit those settings later, touch and hold the camera button, then
tap o to see these options:

e Room: A camera can be located in a room inside your home, or you can create a room for an
outside location such as your front porch or back yard.

e Notifications: Tap Notifications to choose when you'll receive a notification (at any time when
you're not home, for example), when motion is detected, or when a clip is recorded. You can also
choose to allow snapshots in notifications.

e Streaming & Recording: Options include Off, Detect Activity, Stream, and Stream & Allow
Recording.

You can create separate settings for when you're home and when you're away. For example, when
you're home, you might choose to stop streaming and recording for a camera inside your home,
but continue to stream and record from an outdoor camera.

Note: The Home app uses the location of devices belonging to members of the home to switch
between Home and Away modes. For example, when you leave for work with your iPhone, the
camera switches from the When Home settings to the When Away settings.

e Recording Options: Your camera can record when any motion is detected or when specific motion
is detected. Choose Specific Motion and video recording is triggered by the motion of people,
animals, or vehicles.

Tip: Choosing a specific motion, rather than any motion, results in fewer clips (and fewer clip
notifications) and less video to review. For example, choose People, and your camera won't
capture the movement of leaves on a tree or a squirrel leaping from branch to branch.

View video
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1. Tap the camera on the Home screen.

Live video should play automatically.
2. Swipe through the timeline at the bottom of the screen to browse recorded clips.
3. Tap aclip to play it.

4. Pinch the clip open left and right to show the timeline, then drag to go forward or back through
the video.

5. Tap Live to switch back to live video.

When you set up the camera to detect specific motion, the timeline displays unique symbols for
people, animals, and vehicles.

You can also view live and recorded video in the Home app on your Mac with macOS 10.15.1.

Choose access options

To allow other people to view video from your cameras, follow these steps:
1. Tap the Home tab, then tap @ .

2. Below the People heading, tap a person.

3. Tap Cameras, then choose an option.

To learn how to allow other people to view video from your cameras, see Allow others to control
accessories in your home .

Configure a router in Home on iPhone

With iOS 13.2 or later, you can use the Home app ' to make your smart home more secure by
allowing a compatible router to control which services your HomeKit accessories can communicate
with on your home Wi-Fi network and on the Internet. HomeKit-enabled routers require that you have
a HomePod, Apple TV, or iPad set up as a home hub. See the Home accessories website for a list of
compatible routers.

To configure the router’s settings, follow these steps:
1. Set up the router with the manufacturer’'s app on an iOS device.
2. Open the Home app @ , tap the Home tab, then tap ® .

3. Tap Wi-Fi Network & Routers.
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4. Tap an accessory, then choose one of these settings:

e No Restriction: The router allows the accessory to connect to any Internet service or local
device.

This provides the lowest level of security.

e Automatic: The router allows the accessory to connect to an automatically updated list of
manufacturer approved Internet services and local devices.

e Restrict to Home: The router only allows the accessory to connect to your home hub.

This option may prevent firmware updates or other services.

Create and use scenes in Home on iPhone

In the Home app © , you can create scenes that allow you to control multiple accessories at once. For
example, you might define a “Reading” scene that adjusts the lights, plays soft music on HomePod,
closes the drapes, and adjusts the thermostat.

Create a scene
1. Tap the Home tab, tap @ , then tap Add Scene.

2. Tap Custom, enter a name for the scene (such as "Dinner Party” or "Watching TV"), then tap Add
Accessories.

3. Select the accessories you want this scene to include, then tap Done.

The first accessory you select determines the room the scene is assigned to. If you first select
your bedroom lamp, for example, the scene is assigned to your bedroom.

4. Set each accessory to the state you want it in when you run the scene.

For example, for a Reading scene, you could set the bedroom lights to 100 percent, choose a low
volume for the HomePod, and set the thermostat to 68 degrees.

Use scenes

Tap the Rooms tab, tap :=, choose the room the scene is assigned to, then do one of the following:
e Run a scene: Tap the scene.
e Change a scene: Touch and hold a scene.

You can change the scene’s name, test the scene, add or remove accessories, and include the
scene in Favorites.

Favorite scenes appear in the Home tab.
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Control your home using Siri on iPhone

In addition to using the Home app © , you can use Siri to control your accessories and scenes. Here
are some of the things you can say to Siri for the accessories you add and the scenes, rooms, or
homes you set up:

e "Turn off the lights” or “Turn on the lights”
e "Set the temperature to 68 degrees”

¢ "Did I lock the front door?”

¢ “"Show me the entryway camera”

¢ “Turn down the kitchen lights”

¢ "Set my reading scene”

e "Turn off the lights in the Chicago house”

Learn how to ask Siri .

Control your home remotely with iPhone

In the Home app © , you can control your accessories even when you're away from home. To do so,
you need a home hub , a device such as Apple TV (4th generation or later), HomePod, or iPad (with
i0S 10.3, iPadOS 13, or later) that you leave at home.

Go to Settings @ > [your name ] > iCloud, then turn on Home.
You must be signed in with the same Apple ID on your home hub device and your iPhone.
If you have an Apple TV or a HomePod and you're signed in with the same Apple ID as your iPhone,

it's set up automatically as a home hub. To set up iPad as a home hub, see the Home chapter of the
iPad User Guide .

Automate a scene in Home on iPhone

In the Home app @ , you can automate scenes based on the time of day, your location, the activation
of a sensor, or the action of an accessory.

Create an automation
1. Tap the Automation tab.
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2. Tap Create New Automation, then choose one of the following automation triggers:

e When arriving or leaving a location: Tap People Arrive or People Leave, tap Location, then
choose a location. Tap Time to specify when the automation works—during the day, at night,
or at times that you set.

e At atime of day: Tap A Time of Day Occurs, then choose when you want this automation to
run.

If you choose Sunset or Sunrise, times vary as the season changes.

You can also set an automation to only occur after sunset, which is useful for turning on lights
just when they're needed.

e When an accessory changes: Tap An Accessory is Controlled, select an accessory, tap Next,
then follow the onscreen instructions.

You might use this, for example, to run a scene when you unlock the front door.

e A sensor detects something: Tap A Sensor Detects Something, select an accessory, tap Next,
then follow the onscreen instructions.

You might use this, for example, to turn on lights in a stairway when motion is detected nearby.

To disable an automation, tap the Automation tab, tap the automation, then turn off Enable This
Automation.

Add a Siri shortcut

To make your automation even more efficient, you can add a Siri Shortcut to it.

1. When choosing accessories to control with an automation, swipe up, then tap Convert To
Shortcut.

2. Tap &, then choose a shortcut.

See the Shortcuts User Guide .

Allow others to control accessories in your home

In the Home app @ , you can invite other people to control your smart accessories. You and the
people you invite need to be using iCloud and have iOS 11.2.5, iPadOS 13, or later. You also need to
be at your home or have a home hub set up in your home.

Invite others to control accessories

1. Tap the Home tab, then tap @ in the top-left corner of the screen.
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2. Tap Invite.
If you set up more than one home, tap Home Settings, then tap a home.

3. Tap ® to choose people with an Apple ID from your contacts list, or enter their Apple ID email
addresses in the To field.

4. Tap Send Invite.
5. Ask the invitee to do one of the following:
¢ |n the notification: (i0S or iPadOS device) Tap Accept.
e In the Home app: (iOS or iPadOS device) Tap @, then tap their name.

e On Apple TV: Tap Show Me on Apple TV, then turn on one or more Apple TVs.

Allow others to access your AirPlay 2-enabled speakers and TVs
1. Tap the Home tab, then tap ® .

2. Tap Allow Speaker & TV Access, then choose an option.

You can allow everyone, anyone on the same network, or only people you've invited to share the
home. You can also require a password that allows speaker access. To learn more about HomePod
speaker and Apple TV access, see the HomePod User Guide and the Apple TV User Guide .

iTunes Store

Get music, movies, TV shows, and more in the iTunes Store on iPhone

Use the iTunes Store app £ to add music, movies, and TV shows to iPhone.

Find music, movies, TV shows, and more

1. In the iTunes Store, tap any of the following:

e Music, Movies, or TV Shows: Browse by category. To refine your browsing, tap Genres at the
top of the screen.

e Charts: See what’s popular on iTunes.
e Search: Enter what you're looking for, then tap Search on the keyboard.

e More: Browse Genius recommendations or Tones.
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2. Tap an item to see more information about it. You can preview songs, watch trailers for movies
and TV shows, or tap (] to do any of the following:

e Share a link to the item: Choose a sharing option.
e Give the item as a gift: Tap Gift.
e Add the item to your wish list: Tap Add to Wish List.

To view your wish list, tap :=—, then tap Wish List.

Buy and download content

1. To buy an item, tap the price. If the item is free, tap Get.

If you see ¢ instead of a price, you already purchased the item, and you can download it again
without a charge.

2. If required, authenticate your Apple ID with Face ID, Touch ID, or your passcode to complete the
purchase.

3. To see the progress of a download, tap More, then tap Downloads.

Redeem or give an App Store & iTunes Gift Card

1. Tap Music, then scroll to the bottom.

2. Tap Redeem or Send Gift.

Note: You need an Internet connection to use the iTunes Store. The availability of the iTunes Store
and its features varies by country or region. See the Apple Support article Availability of Apple Media
Services .

Manage your iTunes Store purchases and settings on iPhone

In the iTunes Store app &d, you can review and download music, movies, and TV shows purchased by
you or other family members. You can also customize your preferences for the iTunes Store in
Settings.

Approve purchases with Family Sharing

With Family Sharing set up, the family organizer can review and approve purchases made by other
family members under a certain age. See Share purchases with family members on iPhone .

View and download music, movies, or TV shows purchased by you or family members
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1. In the iTunes Store, tap More, then tap Purchased.
2. If you set up Family Sharing, choose a family member to view their purchases.

Note: You can see purchases made by family members only if they choose to share their
purchases.

3. Tap Music, Movies, or TV Shows.

4. Find the item you want to download, then tap | .

View your entire iTunes Store purchase history

To see a chronological list of the apps, songs, movies, TV shows, books, and other items purchased
with your Apple ID, view your iTunes Store purchase history .

In your purchase history, you can do any of the following:
e View when an order was billed to your account.
e View the date of a purchase.
¢ Resend email receipts.

¢ Report a problem with purchased content.

Change your iTunes Store settings

Go to Settings @ > [your name ] > iTunes & App Store, then do any of the following:

e Automatically download music purchased on your other Apple devices: Below Automatic
Downloads, turn on Music.

e Limit iTunes Store downloads to Wi-Fi connections: Below Cellular Data, turn off Automatic
Downloads.

Mail

Write an email in Mail on iPhone

With the Mail app €1, you can write and edit emails, and send and receive photos, videos, drawings,
documents, and more.
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Change mailboxes
or accounts.

< Mailboxes d Delete, move, or mark
Inbox

multiple messages.

® Farrah Tam
Train schedule

© Adam Gooseff
Resume

Chella Boehm
Thank you

Eugene Kim
Running article

Francine Hanson
Desert Photoshoot Selects

Anthony Ashcroft
Appointment

(:x, Updated Just Now

Bt— Compose a message.

Filter messages.

Create an email message

@ Ask Siri. Say something like: “New email to John Bishop” or “Email Simon and say | got the forms,
thanks.” Learn how to ask Siri .

Or do the following:
1. Tap [ .
2. Tap in the email, then type your message.

With the onscreen keyboard, you can tap individual keys or slide your finger from one letter to the
next to type without lifting your finger. (See Enter text using the onscreen keyboard .)

3. To change the formatting, tap < in the format bar above the keyboard, then tap Aa.

You can change the font style, change the color of text, use a bold or italic stye, add a bulleted or
numbered list, and more.

Reply to an email
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1. Tap in the email, tap <3, then tap Reply.
2. Type your response.

With the onscreen keyboard, you can tap individual keys or slide your finger from one letter to the
next to type without lifting your finger. (See Enter text using the onscreen keyboard .)

Quote some text when you reply to an email

When you reply to an email, you can include text from the sender to clarify what you're responding to.

1. In the sender’s email, touch and hold the first word of the text, then drag to the last word. (See
Select and revise text .)

2. Tap <x, tap Reply, then type your message.

To turn off the indentation of quoted text, go to Settings @ > Mail > Increase Quote Level.

Add attachments to an email on iPhone

In the Mail app €1, you can attach photos, videos, scanned documents, and more to an email.

Attach a document to an email

You can attach a saved document to an email.

1. Tap in the email where you want to insert the document, then tap < in the format bar above the
keyboard.

2. Tap[Y above the keyboard, then locate the document in Files .

In Files, tap Browse or Recent at the bottom of the screen, then tap a file, location, or folder to
open it.

3. Tap the document to insert it into your email.

You can also drag a file to your email to attach it to the email.

Insert a saved photo or video

1. Tap in the email where you want to insert the photo or video, then tap < in the format bar above
the keyboard.

2. Tap in the format bar, then locate the photo or video in the photo selector.

You can swipe up to see more images.
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3. Tap the photo or video to insert it into your email.

Take a photo or video to insert into an email

1. Tap in the email where you want to insert the photo or video, then tap < above the keyboard.
2. Tap (O] above the keyboard, then take a new photo or video.

3. Tap Use Photo or Use Video to insert it into your email, or tap Retake if you want to reshoot it.

Scan a document into an email

1. Tap in the email where you want to insert the scanned document, then tap < above the keyboard.
2. Tap & above the keyboard.

3. Position iPhone so that the document page appears on the screen—iPhone automatically captures
the page.

To capture the page manually, tap O or press a volume button. To turn the flash on or off, tap 4 .
4. Scan additional pages, then tap Save when you're done.
5. To make changes to the saved scan, tap it, then do any of the following:
e Crop the image: Tap .
e Apply a filter: Tap & .
e Rotate the image: Tap (' .

e Delete the scan: Tap il .

Mark up an attachment

You can use Markup to write or draw on a photo, video, or PDF attachment.
1. In the email, tap the attachment, then tap @ .

2. Using the drawing tools, draw with your finger.

3. When you're finished, tap Done.

See Draw in apps with Markup on iPhone .

iPhone User Guide 219



T Text
S+ signature

& Maanifier

ooo /~ Tap to add text,
signatures, or shapes,

or use the Magnifier.

Tap to choose
a color.

Select a drawing
tool, the eraser, or
the selection tool.

Draw in your email

1. Tap in the email where you want to insert a drawing, then tap < above the keyboard.

2. Tap @ in the format bar.

3. Choose a drawing tool and color, then write or draw with your finger.
See Draw in apps with Markup on iPhone .
4. When you're finished, tap Done, then tap Insert Drawing.

To resume work on a drawing, tap the drawing, then tap @ .
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Floor plan

Floor plan
Tejo,

Let me draw what | was telling you about
yesterday:
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Address and send email in Mail on iPhone

In the Mail app €1, you can send email from any of your email accounts, mark addresses from outside
certain domains, and more.

Add recipients

1. Tap in the To field, then type the names of recipients.

As you type, Mail automatically suggests people from your Contacts, along with email addresses
for the people who have more than one email address.

You can also tap @ to open Contacts and add recipients from there.
2. If you're sending a copy, tap the Cc/Bcc field.
3. Tap in the Cc field, then enter the names of people you're sending a copy to.

4. Tap in the Bcc field, then enter the names of people whose names you don’t want other recipients
to see.

Tip: After you enter recipients, you can reorder their names in the address fields, or drag them
from one address field to another—for example, to the Bcc field if you decide you don’t want their
names to appear.
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Automatically send a copy to yourself
Go to Settings @ > Mail, then turn on Always Bcc Myself.

Add additional mail accounts

1. Go to Settings @ > Passwords & Accounts > Add Account > Other.
2. Tap Add Mail Account.
3. Enter your name, email address, and password, then tap Next.

4. Enter the names of the incoming and outgoing mail servers for your account and any other
requested information.

5. Tap Save.

Customize your email signature

You can customize the email signature that appears automatically at the bottom of every email you
send.

1. Go to Settings @ > Mail > Signature.
2. Tap in the text field at the top of the screen, then edit your signature.

Tip: If you have more than one email account, tap Per Account to set a different signature for each
account.

Send an email from a different account

If you have more than one email account, you can specify which account to send email from.

Tap the From field to choose an account.

Mark addresses outside certain domains

When you're addressing an email to a recipient who's not in your organization’s domain, you can have
the recipient’s name appear in red to alert you.

1. Go to Settings & > Mail > Mark Addresses.
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2. Enter the domains that are in your organization—ones that you don’t want marked in red.
You can enter multiple domains separated by commas (for example, “apple.com, example.org”).

Any email sent to or from other domains is marked.

View an email in Mail on iPhone

In the Mail app £1, you can preview some of the contents of an email without opening it.

[l ® Farrah Tam
! Train schedule

[l » Adam Gooseff

Resume

Chella Boehm
Thank you

Eugene Kim
Running article

Francine Hanson
Desert Photoshoot Selects

Anthony Ashcroft
Appointment

Updated Just Now

®

Preview an email and a list of options

In a mailbox list, touch and hold an email to preview its contents and see a list of options for replying,
filing it, and more. See Perform quick actions on iPhone .

Show a longer preview

In your mailbox lists, Mail displays two lines of text for each email by default. You can choose to see
more lines of text without opening the email.

Go to Settings @ > Mail > Preview, then choose up to five lines.

iPhone User Guide 223



Draft

Show the whole email

In the list of emails, tap the one you want to read.

Show the whole conversation
Go to Settings @ > Mail, then turn on Organize by Thread.

To change how threads are displayed, you can also change other settings in Settings > Mail—such as
Collapse Read Messages or Most Recent Message on Top.

Show To and Cc labels in your Inbox
Go to Settings @ > Mail, then turn on Show To/Cc Labels.

You can also view the To/Cc mailbox, which gathers all mail addressed to you. To show or hide it, tap
Mailboxes, tap Edit, then select “To or Cc.”

Add someone to your contacts or make them a VIP

In an email, tap a person’s name or email address, then do one of the following:
e To add them to your contacts, tap Create New Contact or Add to Existing Contact.
You can add a phone number, other email addresses, and more.

e To add them to your VIP list, tap Add to VIP.

Save a draft in Mail on iPhone

In the Mail app €1, you can save a draft to finish later, or look at existing emails while you're writing a
new one.

Save a draft for later

If you're writing an email and want to finish it later, tap Cancel, then tap Save Draft. To resume work
on a saved draft email, touch and hold (4 , then select a draft.

You can also swipe down on the title bar of an email you're writing to save it for later. When you're
ready to return to your email, tap its title at the bottom of the screen.

With OS X 10.10 or later, you can also hand off unfinished emails with your Mac. See Hand off tasks
between iPhone and your Mac .
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Flag and filter emails on iPhone

In the Mail app £1, you can flag and filter your emails.

Flag an email

You can flag an email to make it easier to find later. An email you flag remains in your Inbox, but also
appears in the Flagged mailbox. To view the Flagged mailbox, tap Mailboxes at the top left, tap Edit,
then select Flagged.

1. Open the email, tap <§, then tap Flag.
2. To choose a color for the flag, tap a colored dot.

To change or remove a flag, open the email, tap <x , then select another color, or tap N .

N

Farrah Tam Yesterday
To: John Bishop > o

Train schedule

Here it is. Looks like the 8:05 would work
pretty well. Assuming we can get up and
get going that early.

Flags you add to an email appear on that email in Mail on all your Apple devices where you're signed
in with the same Apple ID.

Flag emails from your VIPs
Add important people to your VIP list, so their emails appear with a VIP flag and in the VIP mailbox.

1. While viewing an email, tap the name or email address of a person in the email.
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2. Tap Add to VIP.

Get notified of replies to an email or thread

You can create mail notifications when reading or writing an email.
o When reading an email: Tap <3, then tap Notify Me.
o When writing an email: Tap the Subject field, tap £\ in the Subject field, then tap Notify Me.

You can create mail notifications that let you know when you receive emails in favorite mailboxes or
from your VIPs. To change how notifications appear, go to Settings @ > Notifications > Mail, then turn
on Allow Notifications.

Ask Siri. Say something like: “Any new mail from Nanditha today?"” Learn how to ask Siri .

Mute email notifications

To reduce interruptions from busy email threads, you can mute notifications of the messages in the
conversations.

1. Open an email in the conversation.
2. Tap <y, then tap Mute.

To specify what you want done with emails you muted, go to Settings @ > Mail > Muted Thread
Action, then select an option.

Block email from specified senders

To block a sender, tap their email address, then select “Block this Contact.”

Manage junk mail

To move an email to the Junk folder, open it, tap <§, then tap Move to Junk.

Tip: If you move an email accidentally, immediately swipe left with three fingers to undo.

Filter emails

You can use filters to temporarily show only certain messages—the ones that meet all the criteria you
select in the filter list. For example, if you select “Unread"” and "Only Mail with Attachments,” you see
only unread emails that have attachments.

1. Tap & in the bottom-left corner of a mailbox list.
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2. Tap "Filtered by.”
3. Select or turn on the criteria for emails you want to view.

4. Tap & in the bottom-left corner to hide emails that don’t match the current filters. Tap again to
turn the filter off.

To turn off an active filter, deselect it or turn it off. To turn off all filters, tap the Filter button.

Organize email in Mail on iPhone

In the Mail app €1, manage your email in mailboxes.

Manage an email with a swipe

While viewing an email list you can use a simple swipe to move individual emails to the trash, mark
them as read, and more.

To reveal a list of actions, slowly swipe an email to the left until you see the menu, then tap an item.
To use the rightmost action, quickly swipe all the way to the left.

Swipe right to reveal one other action.

To choose the actions you want to appear in the menus, go to Settings @ > Mail > Swipe Options.

Organize your mail with mailboxes

In the Mailboxes list, you can view all your mailboxes, create a new one, or rename or delete one.
(Some mailboxes can't be changed.)

1. Tap Mailboxes in the upper-left corner.
2. Tap Edit at the top of the list.
3. Select the checkboxes next to a mailbox you want to view.

There are several smart mailboxes, such as Unread, that show emails from all your accounts. Tap
the mailboxes you want to view.

4. To add a mailbox, tap New Mailbox at the bottom of the list.

5. Enter a name and specify a location, then tap Save.

Reorder your mailboxes

You can reorder your mailboxes so that the ones you use most often appear at the top of the
Mailboxes list.
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1. Tap Mailboxes in the upper-left corner.
2. Tap Edit at the top of the list.

3. Touch and hold = next to a mailbox until it lifts up, then drag it to the position you want.

Move or mark multiple emails

1. While viewing a list of emails, tap Edit.

2. Select the emails you want to move or mark by tapping their checkboxes.
To select multiple emails quickly, swipe down through the checkboxes.

3. Choose the action you want to perform on all the selected emails.

If you change your mind, immediately swipe left with three fingers to undo.

Show draft emails from all of your accounts

If you have more than one email account, you can show draft emails from all your accounts.
1. Tap Mailboxes in the upper-left corner.
2. Tap Edit at the top of the list.

3. Tap Add Mailbox, then turn on the All Drafts mailbox.

Search for email in Mail on iPhone

In the Mail app €1, you can search for emails using different criteria.

Search for text in an email

1. Swipe down from the middle of a mailbox list to reveal the search field.

2. Tap in the search field, then type the text you're looking for.

3. Choose between searching all mailboxes or the current mailbox above the results list.
4. Tap an email in the results list to see it.

Searching looks at the address fields, the subject, and the email body. The most relevant emails
appear in Top Hits above the search suggestions as you type.
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Search by timeframe

Swipe down from the middle of a mailbox list to reveal the search field, tap in the search field, then
type something like “February meeting” to find all emails from February with the word “meeting.”

Search by email attributes

You can search for emails by various attributes. For example, you can do any of the following:
e Find all flagged emails: Type “flag" in the search field, then tap Flagged Messages below Other.

e Find all emails from people in your VIP list: Type "vip" in the search field, then tap Messages from
VIPs below Other.

e Find all unread emails: Type "unread” in the search field, then tap Unread Messages below Other.

e Find all email with attachments: Type "attachment” in the search field, then tap Messages with
Attachments below Other.

Delete and recover emails in Mail on iPhone

In the Mail app £1, delete emails you no longer need.

Delete emails

There are multiple ways to delete emails. Do any of the following:
o While viewing an email: Tap [i| at the bottom of the email.
e While viewing the email list: Swipe an email left, then choose Trash from the menu.
To delete the email in a single gesture, swipe it all the way to the left.

e Delete multiple emails at once: While viewing a list of emails, tap Edit, select the emails you want
to delete, then tap Trash.

To select multiple emails quickly, swipe down through the checkboxes.

To turn the confirmation of deletion on or off, go to Settings @ > Mail, then turn on or off Ask Before
Deleting.

If you change your mind, immediately swipe left with three fingers to undo.

Recover a deleted email

1. Go to the account’s Trash mailbox, then open the email.
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2. Tap <7, then move the message to another mailbox.
If you change your mind, immediately swipe left with three fingers to undo.

Tip: To see deleted emails across all your accounts, tap Mailboxes at the top left, tap Edit at the
top of the list, then select the All Trash mailbox.

Archive instead of delete

Instead of deleting emails, you can archive them in the Archive mailbox. (You can still delete emails,
even if you set up an Archive mailbox.)

1. Go to Settings @ > Passwords & Accounts.
2. Tap your email account, tap Mail (below Advanced), then tap Advanced.
3. In the Advanced settings, change the destination mailbox for discarded emails to Archive Mailbox.

When this option is turned on, to delete an email instead of archiving it, touch and hold =, then tap
Trash Message.

Decide how long to keep deleted emails

You can set how long deleted emails stay in the Trash mailbox.

1. Go to Settings @ > Passwords & Accounts.

2. Tap your email account, tap Mail (below Advanced), then tap Advanced.
3. In the Advanced settings, tap Remove, then select a time interval.

Note: Some email services might override your selection; for example, iCloud doesn’t keep deleted
emails longer than 30 days, even if you select Never.

Work with email attachments on iPhone

In the Mail app €1, preview, save, open, and annotate email attachments.

Preview an attachment

Touch and hold an attachment to preview it and see a list of actions you can perform.

Save a photo or video attachment to Photos
Touch and hold the photo or video, then tap Add to Photos.
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Open an attachment with another app

1. Touch and hold the attachment until a menu appears.
2. Tap ("1, then choose the app you want to use to open the attachment.

Note: Some attachments automatically show a banner with buttons you can use to open other apps.

See emails with attachments

1. In a mailbox, tap & to turn on filtering.
2. Tap "Filtered by,"” then turn on “Only Mail with Attachments.”

You can also use the Attachments mailbox, which shows emails with attachments from all accounts.
To view it, tap Mailboxes at the top left, tap Edit above the Mailboxes list, then select Attachments.

Send large attachments

Mail Drop is an iCloud feature you can use to send files exceeding the maximum size allowed by your
email account.

To use Mail Drop, tap Send when you're ready to send an email with large attachments, then follow
the onscreen instructions.

Mail must be turned on in Settings @ > [your name ] > iCloud. See the Apple Support article Mail Drop
limits .

To learn how to send any attachment, see Add attachments to an email on iPhone .

Print an email or attachment in Mail on iPhone

In the Mail app £, print an email or an attachment.

Print an email
In the email, tap <3, then tap Print.

Print an attachment or picture

Tap an attachment to view it, tap (1, then choose Print.
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Maps

View maps on iPhone

In the Maps app 45, find your location on a map and zoom in and out to see the detail you need.

To find your location, iPhone must be connected to the Internet, and Location Services must be on.
(See Set which apps can access your location on iPhone .) Cellular data rates may apply. (See View or
change cellular settings on iPhone .)

WARNING: For important information about navigation and avoiding distractions that could lead to
dangerous situations, see Important safety information for iPhone .

Show your current location
Tap </ .

Work Coffee

S| Week in SF

Your position is marked in the middle of the map. The top of the map is north. To show your heading
instead of north at the top, tap 4/ . To resume showing north, tap A or & .
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Choose between road, transit, and satellite views
Tap @, choose Map, Transit, or Satellite, then tap

If transit information is unavailable, tap View Routing Apps to use an app for public or other modes of
transportation.

Move, zoom, and rotate a map

e Move around in a map: Drag the map.

e Zoom in or out: Double-tap and hold your finger to the screen, then drag up to zoom in or drag
down to zoom out. Or, pinch open or closed on the map.

The scale appears in the upper left while you're zooming. To change the unit of distance, go to
Settings @ > Maps, then select In Miles or In Kilometers.

e Rotate the map: Touch and hold the map with two fingers, then rotate your fingers.

To show north at the top of the screen after you rotate the map, tap & .

View a 3D map

e On a 2D road or transit map: Drag two fingers up.

e On a 2D satellite map: Tap 3D near the upper right.
While viewing a 3D map, you can do the following:

e Adjust the angle: Drag two fingers up or down.

¢ See buildings and other small features in 3D: Zoom in.

e Return to a 2D map: Tap 2D near the upper right.

Find places in Maps on iPhone

Use the Maps app &s to find attractions, services, and more.

If you install apps that have map extensions, you may be able to do things like make a reservation at a
restaurant and order a ridesharing vehicle to take you there. Visit the App Store to find apps that work
with Maps.

Search for a place

Ask Siri. Say something like: “Show me the Golden Gate Bridge.” Learn how to ask Siri .
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Or you can tap the search field, then begin typing.
You can search in different ways. For example:

¢ Intersection ("8th and Market")

e Area ("Greenwich Village")

e Landmark ("Guggenheim")

e Zip code ("60622")

e Business (“movies,” “restaurants San Francisco CA,” “Apple Inc New York")
To see all results, swipe up on the search card.

Note: If you see an information card instead of the search field, tap >< in the top right of the
information card.

Find nearby attractions, services, and more

@ Ask Siri. Say something like: “Find a gas station” or “Find coffee near me.” Learn how to ask Siri .

Or you can tap the search field, tap a category such as Groceries or Hotels, then do any of the
following:

o See all results for the category: Swipe up on the information card.

e Change the search area: Drag the map to another area or zoom in or out, then tap Search Here at
the bottom of the information card.

e See more information about a result: Tap the item on the information card.
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Tip: Use the Maps Nearby widget to quickly find nearby attractions and services. See Add and
organize Today View widgets .

Nearby suggestions are not available in all regions. See the iOS and iPadOS Feature Availability
website .

Find your way around an airport, transit station, or shopping mall

1. Do one of the following:

e When you're at the location: Open Maps, tap </ to show your current location, then tap Look
Inside—or zoom in, then tap the Browse button at the bottom of the information card.

e Before you get to the location: Search for the location in Maps or drag the map to show the
location. Zoom in, then tap the Browse button.

2. To find nearby services, tap a category (like Food, Restrooms, or Gates) on the information card,
then swipe up to see all results, listed alphabetically.

To see more information about a result, tap it.

3. To see a map of a different floor, tap the button showing the floor level (zoom in if you don’t see
the button).
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— Change the floor level.

Terminal 4
Airport Terminal

Note: Indoor maps for airports, transit stations, and shopping malls are not available in all regions.
See the iOS and iPadOS Feature Availability website .

Quickly find or delete recently viewed places

To see a list of recently viewed places, swipe up from the top of the search card, then scroll to the
bottom of the card.

To delete an item from the list, swipe the item left. Or tap See All directly above the list, then do one
of the following:

e Delete a group: Tap Clear above the group.
e Delete a single item: Swipe the item left.

See also Delete significant locations .

Look around in Maps on iPhone

View cities in the Maps app 4: in an interactive 3D experience that lets you pan 360 degrees and
move through the streets.

1. In select cities, tap && on a map or information card.
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2. To change the view, do any of the following:
e Pan: Drag a finger left or right.

e Move forward: Tap the scene.

Zoom in or out: Pinch open or closed.

View another point of interest: Tap elsewhere on the map.

Switch to or from full-screen view: Tap M or & .

Hide labels in full-screen view: Tap the information card at the bottom of the screen, then tap

3. When finished, tap Done.

Transamerica Pyramid
Landmark - 6.4 mi

Mark places in Maps on iPhone

You can mark places in the Maps app 4: with pins to help you find those places later.

Tip: To quickly mark your location so you can find your way back later, touch and hold the Maps
icon on the Home screen, then choose Mark My Location. See Perform quick actions on iPhone .
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Mark an unlabeled location on the map

1. Touch and hold the map until a pin marker appears.

2. To help you find the location later, you can save it to your favorites, to a collection, or to Contacts.

Swipe up on the information card, then choose an option.

3. To close the information card, tap

Delete a pin marker
1. Tap the marker.

2. On the information card, tap Remove Marker.
You can also touch and hold the marker, then tap Remove Marker.

See Delete significant locations .

Get information about a place in Maps on iPhone

Find street addresses and other information about places that appear in the Maps app ¥ .

See information about a place

Tap a location on a map or an item in a list of search results, then do any of the following:
e Get a route to the location: Tap Directions.
e View more information: Swipe up on the information card.

The information might include the street address, a phone number, a webpage link, business
hours, and customer reviews.

e Close the information card: Tap
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La Mar SF

Peruvian - 6.9 mi

Reservations Directions
peniabl 22 min drive

Save information about a place

Tap a location on a map or an item in a list of search results, then do any of the following:
e Add the place to a collection: Tap "Add to.”
Scroll part way down the information card if you don't see “Add to.”

e Add the place to your favorites: Scroll to the bottom of the information card, then tap Add to
Favorites.

¢ Add the place to Contacts: Scroll to the bottom of the information card, then tap Create a New
Contact or Add to Existing Contact.

See Save favorite places in Maps on iPhone and Create collections in Maps on iPhone .

Share places in Maps on iPhone
In the Maps app 4s , share places with others. For example, you can send a message or email to show

people where to meet you.

1. Tap a place on the map.
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2. Tap ("] on the information card, then choose an option.

You can also touch and hold the place, then tap Share Location.

Tip: To quickly share your current location, touch and hold Maps on the Home screen, then tap
Send My Location. See Perform quick actions from the Home screen .

Save favorite places in Maps on iPhone

In the Maps app 4s , save a place—such as a landmark, a business, a home, or a spot that you marked
with a pin—to your favorites list. You can quickly find your favorites on the search card, directly below
the search field.

~San Francisco
()

"Daly City

Y=

Work Coffee

Smmw| Week in SF

Add a place to your favorites

1. Swipe up from the top of the search card to show Favorites.
2. Tap —+ on the right side of the row.

If you don't see +, swipe the Favorites row left.
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3. Do one of the following:

e Choose a suggestion below the search field.

e Enter a place or address in the search field, then choose a search result.
4. To rename the favorite, tap the title, then enter a new name.
5. Tap Done.

You can also tap a location on a map or choose an item in a list of search results, then tap Add to
Favorites (at the bottom of the information card).

Add a transit stop to your favorites

1. Find a transit route , then tap Go.
2. Tap a transit stop or station.
3. Scroll to the bottom of the information card, tap Add to Favorites, then tap

Adding a transit line to your favorites also adds it to the Maps Transit widget in Today View. You can
use the widget to quickly check the line's operating status. (See Add and organize Today View
widgets .)

Quickly find your favorites

Swipe up from the top of the search card to see several favorites.

To see more, swipe the row of favorites left or tap See All above the row.

Edit a favorite

1. Swipe up from the top of the search card to show Favorites, then tap See All above the row of
favorites.

2. Tap @ next to the favorite.
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3. Depending on the location, you may be able to make the following changes:
e Rename the favorite: Tap the title, then enter a new name.
e Change the address: Tap the address, then tap Open Contact Card.
e Adjust the location on the map: Tap Refine Location on the Map.
e Change the label: Tap a label type.
e Delete the location from your favorites list: Tap Remove Favorite.

e Tell someone your ETA: (i0S 13.1 or later) Tap Add Person, then choose one or more
suggested contacts, or search for a contact. Whenever you start turn-by-turn navigation to
this location, the person automatically receives a notification about your estimated time of
arrival (ETA). See Share your ETA .

4. Tap Done.

Delete a place from your favorites

Swipe up from the top of the search card to show Favorites, tap See All above the row of favorites,
then swipe the item left.

Create collections in Maps on iPhone

In the Maps app &<, you can organize related places into collections for easy reference. For example,
you can add destinations for an upcoming vacation into a collection named Summer Road Trip . You
can quickly get to your collections from the search card, below Favorites, and you can share your
collections with others.

Create a collection

Swipe up from the top of the search card, then do one of the following:
e Create one of your first three collections: Tap New Collection, enter a name, then tap Create.

e Create additional collections: When the New Collection button no longer appears, tap See All
above the list of collections, tap - at the bottom of the list, enter a name, tap Create, then tap
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o Transamerica Pyramid

Add a place to a collection

1. Tap alocation on a map or an item in a list of search results.

2. Tap "Add to," then choose a collection.

Share a collection

1. Swipe up from the top of the search card to show Collections, then choose a collection.
If you don’t see Collections, continue swiping up.

2. Swipe up on the collection card, tap (11, then choose an option.

Edit a collection

1. Swipe up from the top of the search card to show Collections, then choose a collection.
If you don’t see Collections, continue swiping up.

2. Swipe up on the collection card, then tap Edit at the bottom of the screen.
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3. Do any of the following:
e Rename the collection: Tap the title.
e Delete a place from the collection: Tap the place, then tap Delete at the bottom of the screen.
e Change the sort order: Tap Date Added, Name, or Distance, then choose an option.

4. Tap

Get traffic and weather info in Maps on iPhone

In the Maps app és , view traffic conditions and find out about the weather.

Find out about traffic conditions

1. From map or satellite view, tap @ .
If you're in transit view, tap @ , then choose Map or Satellite.
2. Turn on Traffic, then tap
Orange indicates slowdowns, and red indicates stop-and-go traffic.
3. To see anincident report, tap an incident marker (not available in all countries or regions).

Incident markers show information such as lane closures 4\, road closures @, road construction
® , accidents &, and more.

Find out about the weather

Zoom in on a map until the weather icon appears in the lower-right corner; the icon shows the current
conditions for that area. In some regions, the air quality index also appears in the lower-right corner.

To see the hourly forecast, touch and hold the weather icon. Tap the hourly forecast to see the 10-
day forecast in the Weather app.

If you don't want to see the weather information or the air quality index in Maps, go to Settings @ >
Maps, then turn off Weather Conditions or Air Quality Index.

Get directions in Maps on iPhone

Get driving, transit, and walking directions in the Maps app % .

Tip: Add your home and work addresses to your My Info card in Contacts, then you can use
"work" or "home" when searching in Maps or asking Siri. See Add your contact info on iPhone .
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To get directions, iPhone must be connected to the Internet. Cellular data rates may apply. (See View
or change cellular settings on iPhone .) To get directions involving your current location, Location
Services must be on. (See Set which apps can access your location on iPhone .)

Find a route

@ Ask Siri. Say something like: “Give me directions home" or “Transit directions to my dad'’s work."
Learn how to ask Siri .

Or you can do one of the following:

e Tap the place you want directions to (for example, a landmark on a map, a spot that you marked
with a pin, or a search result), then tap Directions on the information card.

e Touch and hold a location on a map, then tap Directions.

Maps shows directions from your current location. To see detailed directions for the route, tap Go.
(See Follow turn-by-turn directions in Maps on iPhone .)

.//
‘u. 4 ka)‘ -/

<
O31st'a™idah

To La Mar SF

From My Locs

1hr 3 min

Tip: Use the Maps Destination widget to quickly get directions for likely destinations. Use the
Maps Transit widget to quickly get information about transit destinations. See Add and organize
Today View widgets .
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Change the route

With a route showing, you can do the following before you tap Go for detailed directions:
e Choose from alternate routes: If alternate routes appear, tap one to take it.

e Reverse the starting point and destination: Tap My Location (near the top of the route card), then
tap .

e Choose a different starting point or destination: Tap My Location, tap either the From or To field,
then enter a different location.

e See a driving, walking, or transit route: Tap Drive, Walk, or Transit.

In select cities, Maps provides public transportation information, which includes walking directions
to a bus stop or train station. If transit route information is unavailable, tap View Routing Apps to
use an app for other modes of transportation.

e Avoid tolls or highways: With a driving route showing, swipe the route card up, scroll to the
bottom of the list, tap Driving Options, then turn on Tolls or Highways.

Choose a transit time or date

With a transit route showing, and before you tap Go for detailed directions, tap Leaving Soon (near
the top of the route card), then select a time or date for departure or arrival.

To choose which transit vehicles to consider, tap Transit Options.

Delete arecently viewed route

Swipe up from the top of the search card to see Recently Viewed, then swipe a recent route left. Or
tap See All directly above the list, then do one of the following:

e Delete a group of routes: Tap Clear above the group.
o Delete a single route: Swipe the route left.

See also Delete significant locations .

Use Maps on your Mac to get directions

You can get directions on a Mac (OS X 10.9 or later) and send them to your iPhone. You must be
signed in with the same Apple ID on both your Mac and your iPhone.

1. In Maps on your Mac, find a route for your trip.

2. Choose File > Share > Send to [your device ].
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You can also use Handoff to send directions from iPhone to Mac. See Hand off tasks between iPhone
and your Mac .

Follow turn-by-turn directions in Maps on iPhone

In the Maps app és , follow detailed, turn-by-turn directions for driving, transit, and walking routes
(not available in all countries or regions).

To provide directions, iPhone must be connected to the Internet. Cellular data rates may apply. (See
View or change cellular settings on iPhone .) To provide directions involving your current location,
Location Services must be on. (See Set which apps can access your location on iPhone .)

Hear turn-by-turn driving directions

@ Ask Siri. Say something like: “Give me directions home.” Learn how to ask Siri .
Or you can find a driving route , then tap Go.
As Maps follows your progress, it speaks turn-by-turn directions to your destination.

To end directions at any time, tap End, or say something to Siri like “Stop navigating.”

300 ft
30th Ave Tap for the route overview.

r’ Fulton St

John F Kennedy Dr

10:17 36 6.5 m }Tapfor more options.
arrival min mi

Share ETA i— Tap to share your estimated
J) time of arrival.

o 29th Ave

iPhone User Guide 247



Draft

When Do Not Disturb while driving is turned on, or if iPhone auto-locks, Maps stays onscreen and
continues to announce directions. Even if you open another app, Maps continues to give you turn-by-
turn directions. (To return to Maps from another app, tap the banner across the top of the screen.)

See an overview of your driving route

With turn-by-turn driving directions showing, tap the turn directions at the top of the screen.

In upper-left corner, the screen shows only your next turn, which may be all you want, especially
when you're familiar with the route. You can do the following:

e Show the destination instead of north at the top of the screen: Tap the map, then tap = .
e Show north instead of the destination at the top of the screen. Tap the map, then tap ¢

e Return to turn-by-turn guidance: Tap the turn directions in the upper-left corner of the screen.

See a list of your turn-by-turn driving directions

With turn-by-turn driving directions showing, tap the route card at the bottom of the screen, then tap
Details.

To view the map again, tap Done.

Make a stop along your driving route

Ask Siri. Say something like “Hey Siri, find a gas station.”
Or you can do the following:
1. Tap the route card at the bottom of the screen.

2. Tap one of the suggested services (such as gas stations), then tap Go.

Share your ETA

As you follow turn-by-turn driving instructions, you can let others know your estimated time of arrival
(ETA) (i0S 13.1 or later).

1. With turn-by-turn directions showing, tap the route card, then tap Share ETA.

2. Choose one or more suggested contacts, or tap Contacts to find a contact.
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3. You can do the following during your trip:

e Cancel sending ETA information: Tap Sharing ETA at the bottom of the screen, then choose a
contact.

e Replace the Sharing ETA card with the route card: Tap > on the Sharing ETA card.

People using devices with i0OS 13.1, iPadOS 13.1, or later receive a Maps notification with your ETA,
and they can track your progress in Maps. People using devices with earlier versions receive the
notification through iMessage. People using other mobile devices receive an SMS message.

Note: Standard carrier data and text rates may apply.

View turn-by-turn or stop-by-stop directions for walking or transit routes

@ Ask Siri. Say something like: “Transit directions to my dad’'s work.” Learn how to ask Siri .
Or you can find a walking or transit route , then tap Go.

As Maps follows your progress, it shows your location on the route. Do any of the following at any
time during your trip:

e End directions at any time: Tap End, or say something to Siri like “Stop navigating.”
e See the next instruction: Swipe left on the banner at the top of the screen.
o View the directions in a list: Tap the route card at the bottom of the screen, then tap Details.

e See the route overview: Tap the route card at the bottom of the screen, then tap Overview. To see
more detail, tap the route card, then tap “Turn-by-turn” (for a walk route) or Zoom In (for a transit
route).

e Add a transit stop to Favorites: See Add a transit stop to your favorites .
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Exit train at
Embarcadero

After Montgomery St

.

Ride 35 minutes (22 stops)
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<115t & Judah
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To La Mar SF
1hr 2 min

Find your car using Maps on iPhone

In the Maps app 4s, you can get directions to your parked car. When you disconnect iPhone from
your car'’s Bluetooth or CarPlay system and exit your vehicle, Maps drops a parked car marker so you
can easily find your car.

Find where you left your car

Tap the search field, then choose Parked Car from the suggestions list.

Turn parking location off
Go to Settings @ > Maps, then turn off Show Parked Location.

Book a ride in Maps on iPhone

In the Maps app 4=, you can request a ride with a ridesharing app (not available in all countries or
regions). If you don’t have one installed, Maps shows you apps that are available from the App Store.
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@ Ask Siri. Say something like: “Get me a ride home."” Learn how to ask Siri .

Or you can find your destination , tap Directions, then tap Ride (at the bottom right).

Take Flyover tours in Maps on iPhone

In the Maps app &=, you can fly over many of the world's major landmarks and cities. Flyover
landmarks are identified by the Flyover button on their information cards. Flyover cities are indicated
by @ next to their names in map view.

View a city or landmark from above

1. Tap the name of a city (in map or satellite view) or the name of a landmark.

If you don't see @ markers for cities, zoom out, or if you're using transit view, tap @ , then choose
Map or Satellite.

2. Tap Flyover on the information card.

Golden Gate
Aridge

Golden Gate Bridge
Landmark - 3.1 mi

T i— View a city or landmark

12 min drive
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3. Do any of the following:
e Change viewing direction: Point or tilt iPhone in the direction you want to view.

e Move around: Drag a finger in any direction. To rotate perspective, touch and hold the screen
with one finger, then continue holding it in place while you drag another finger around it.

e Watch an aerial 3D tour: Tap Start Tour or Start City Tour in the card at the bottom of the
screen. (If you don’t see the card, tap anywhere on the screen.)

4. To return to the map, tap < (tap anywhere on the screen if you don’t see < ).

Help improve Maps on iPhone

To report a missing location, an incorrect label, or other issue in the Maps app ¥, tap @ in the upper-
right corner of the map, then tap Report an Issue.

Measure

Measure dimensions with iPhone

Use the Measure app & and your iPhone camera to measure nearby objects. iPhone automatically
detects the dimensions of rectangular objects, or you can manually set the start and end points of a
measurement.
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For best results, use Measure on well-defined objects located 0.5 to 3 meters (2 to 10 feet) from
iPhone.

Note: Measurements are approximate.

Start a measurement

1. Open Measure @ , then use the iPhone camera to slowly scan nearby objects.

2. Position iPhone so that the object you want to measure appears on the screen.

Take an automatic rectangle measurement

1. When iPhone detects the edges of the rectangular object, a yellow box frames the object; tap the
yellow box to see the dimensions.

2. To take a photo of your measurement, tap O .

Take a manual measurement

1. Align the dot at the center of the screen with the point where you want to start measuring, then
tap @ .
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2. Slowly pan iPhone to the end point, then tap (©) to see the measured length.
3. To take a photo of your measurement, tap O .

4. Take another measurement, or tap Clear to start over.

Use iPhone as alevel

Use your iPhone to determine whether an object near you is level, straight, or flat (measurements are

approximate).

1. Open Measure.

2. Tap Level, then hold iPhone against an object, such as a picture frame.
o Make an object level: Rotate the object and iPhone until you see green.

e Match the slope: Tap the screen to capture the slope of the first object. Hold iPhone against
another object and rotate them until the screen turns green.

To reset the level, tap the screen again.
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Messages

Set up Messages on iPhone

In the Messages app (J, you can send text messages as SMS/MMS messages through your cellular
service, or with iMessage over Wi-Fi or cellular service to people who use iPhone, iPad, iPod touch, or
a Mac. Texts you send and receive using iMessage don’t count against your SMS/MMS allowances in
your cellular messaging plan, but cellular data rates may apply.

iMessage texts can include photos, videos, and other info. You can see when other people are typing,
and send read receipts to let them know when you’ve read their messages. For security, messages
sent using iMessage are encrypted before they're sent.

iMessage texts appear in blue bubbles, and SMS/MMS texts appear in green bubbles. See the Apple
Support article About iMessage and SMS/MMS .

Sign in to iMessage
1. Go to Settings @& > Messages.

2. Turn on iMessage.

Sign in to iMessage on your Mac and other Apple devices using the same Apple ID

If you sign in to iMessage with the same Apple ID on all your devices, all the messages that you send
and receive on iPhone also appear on your other Apple devices. Send a message from whichever
device is closest to you, or use Handoff to start a conversation on one device and continue it on
another.

1. Onyour iPhone, iPad, or iPod touch, go to Settings @ > Messages, then turn on iMessage.
2. On your Mac, open Messages, then do one of the following:
e If you're signing in for the first time, enter your Apple ID and password, then click Sign In.

e If you signed in before and want to use a different Apple ID, choose Messages > Preferences,
click iMessage, then click Sign Out.

With Continuity, all the SMS/MMS messages you send and receive on iPhone also appear on your
other iOS devices and your Mac. See the Apple Support article Use Continuity to connect your Mac,
iPhone, iPad, iPod touch, and Apple Watch .
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Use Messages in iCloud
Go to Settings @ > [your name ] > iCloud, then turn on Messages (if it's not already turned on).
Every message you send and receive on your iPhone is saved in iCloud. And, when you sign in with

the same Apple ID on a new device that also has Messages in iCloud turned on, all your conversations
show up there automatically.

Because your messages and any attachments are stored in iCloud, you may have more free space on
your iPhone when you need it. Message bubbles, whole conversations, and attachments you delete
from iPhone are also deleted from your other Apple devices (iOS 11.4, iPadOS 13, macOS 10.13.5, or
later) where Messages in iCloud is turned on.

See the Apple Support article Keep all your messages in iCloud .

Note: Messages in iCloud uses iCloud storage. See Manage Apple ID and iCloud settings on iPhone
for information about iCloud storage.

Send and receive text messages on iPhone

Use the Messages app (J to send and receive texts, photos, videos, and audio messages. You can
also personalize your messages with animated effects, Memoji stickers, iMessage apps, and more.

— View contact info and
conversation details.

Hey, I'm running late.

No worries, me too. Wanna just
go straight to eat?

Sure, so hungry. Wanna get
tacos?

(O 2 o

+t OD@a® c O -

Q0%
e 0oe
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WARNING: For important information about avoiding distractions while driving, see Important safety
information for iPhone .

Send a message

You can send a text message to one or more people.

1. Tap (4 at the top of the screen to start a new message, or tap an existing message.

Messages ~g1— Start a conversation.

Mayuri Patel
a°

Gordon Garb

A blue dot indicates
unread messages.

2. Enter the phone number, contact name, or Apple ID of each recipient. Or, tap @, then choose
contacts.

¢ On models with Dual SIM , to send an SMS/MMS message from a different line, tap the line
shown, then choose the other line. See also Manage your cellular plans .

3. Tap the text field, type your message, then tap @ to send.
e An alert () appears if a message can’t be sent. Tap the alert to try sending the message again.
Tip: To see what time a message was sent or received, drag the message bubble to the left.

To view conversation details, tap the name or phone number at the top of the screen, then tap
You can tap the contact to edit the contact card, share your location, view attachments, leave a group
conversation, and more.

To return to the messages list from a conversation, tap < or swipe from the left edge.

Reply to a message

@ Ask Siri. Say something like:
e "Send a message to Eliza saying how about tomorrow”
e "Reply that's great news”
e "Read my last message from Bob”

Learn how to ask Siri
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Tip: When you wear AirPods Pro, AirPods (2nd generation), or other supported headphones, Siri
can read your incoming messages, and you can speak a reply for Siri to send (i0S 13.2 or later). See
Listen and respond to messages .

Or do the following:
1. In the Messages list, tap the conversation that you want to reply to.

To search for contacts and content in conversations, pull down the Messages list and enter what
you're looking for in the search field. Or, choose from the suggested contacts, links, photos, and
more.

2. Tap the text field, then type your message.
Tip: To replace text with emoji, tap © or & , then tap each highlighted word.
3. Tap @ to send your message.

You can quickly reply to a message with a Tapback expression (for example, a thumbs up or a heart).
Double-tap the message bubble that you want to respond to, then select a Tapback.

Share your name and photo

In Messages, you can share your name and photo when you start or respond to a new message. Your
photo can be a Memoji, Animoji, or custom image. When you open Messages for the first time, follow
the instructions on your iPhone to choose your name and photo.

To change your name, photo, or sharing options, open Messages, tap - , tap Edit Name and Photo,
then do any of the following:

e Change your profile image : Tap Edit, then choose an option.
¢ Change your name : Tap the text fields where your name appears.

e Turn sharing on or off : Tap the button next to Name and Photo Sharing (green indicates that it's
on).

e Change who can see your profile : Tap an option below Share Automatically (Name and Photo
Sharing must be turned on).

Your Messages name and photo can also be used for your Apple ID and My Card in Contacts.

Switch from a Messages conversation to a FaceTime or audio call

In a Messages conversation, you can initiate a FaceTime or audio call with the person you're chatting
with in Messages.

1. In a Messages conversation, tap the profile picture or the name at the top of the conversation.
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Use Business Chat

(Beta) In Messages, you can communicate with businesses that offer Business Chat. You can get
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answers to questions, resolve issues, get advice on what to buy, make purchases with Apple Pay, and

more.

1. Search for the business you want to chat with using Maps, Safari, Search, or Siri.

2. Start a conversation by tapping a chat link in the search results—for example, ® , the company
logo, or a text link (the appearance of the chat link varies with the context).

9:417
Q apple store
. Apple Infinite Loop

02 miles «+ 9 A

Apple Park Visitor...
(106) o

10600 N Tanta >

1A milex « § AM -7 PM

-

Apple Valley Fair
(769) o

2866 Stevens Creek Bl

4.6 miles « 10 AM~-9:3

-

SIRI SUGGESTE

Infinite Loop - Apple Store - Apple

Apple Store Infinite Loop store hours,

contact information, and weekly calenda

Apple com/reta

- Apple (United Kingdom)
Shop averything IPhone, iPad, Apple

Witch, Mac and Apple TV, explore acces.

HE < DApple Store %R T -
Apple Store

Mac iPad. Apple Wa
"3 i < mApple Store

You can also initiate a chat with some businesses from their website or iOS app. See the Apple

Tap here to start
a conversation with
this business.

Support article How to use Business Chat .

Note: Business Chat messages you send appear in dark gray, to distinguish them from iMessages (in
blue) and SMS/MMS messages (in green).
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Send photos, videos, and audio messages on iPhone

In the Messages app (J, you can send photos, videos, and audio messages using iMessage or your
SMS/MMS service. You can also share, save, or print attachments. Your carrier may set size limits for
attachments; iPhone may compress photo and video attachments when necessary.

For information about sending SMS/MMS attachments on models with Dual SIM , see Manage your
cellular plans .

Send a photo or video

1. In Messages, do any of the following while writing a message:
e Take a photo within Messages: Tap E&l, frame the shot in the viewfinder, then tap O .
e Take a video within Messages: Tap E&l, choose Video mode, then tap @ .

e Choose an existing photo or video: Tap % in the app drawer, then swipe left to browse through
recent shots, or tap All Photos.

@

Gordon

Definitely. Sign us up for
another session?

No problem. It's $45 for each
of us.

How was your trip?

I can't wait to see photos.

(o 2 [
OO -

Recent Photos All Photos

2. Tap @ to send your message or @ to cancel.
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Mark up or edit a photo

You can mark up or edit a photo before you send it in a Messages conversation.

Cancel Markup (%)

1. Tap % in the app drawer, then choose a photo.

2. Tap the photo in the message bubble, then do any of the following:
e Tap Markup, use the Markup tools to draw on the photo, then tap Save.
e Tap Edit, use the photo editing tools to edit the photo, then tap Done.

3. Tap Done, add a message, then tap @ to send the photo, or tap @ to remove the photo from the
message bubble.

Add camera effects to a photo or video

When you take a photo or video in a Messages conversation, you can add camera effects to it—such
as filters, stickers, labels, and shapes.

1. In a Messages conversation, tap E&l, then choose Photo or Video mode.
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2. Tap @ , then do any of the following:

e Tap @, then choose an Animoji (on supported models ).

e Tap @, then choose a filter to apply to your picture.

e Tap @ to add a text label, or @ to add a shape.

e Tap @ to add a Memoji sticker, or @ to add an Emoji sticker.
3. Tap & to close the effect window.
4. Tap O to take a photo or @ to record video.

5. Tap Done to add the photo or video to the message bubble, where you can add a message, or tap
© to send the photo or video directly.

Send an audio message

1. In a conversation, touch and hold € to record an audio message.
2. Tap (» to listen to your message before you send it.
3. Tap @ to send the message or () to cancel.

Note: To save space, iPhone automatically deletes audio messages two minutes after you listen to
them, unless you tap Keep. To always keep audio messages, go to Settings @ > Messages > Expire
(below Audio Messages), then tap Never.

Listen or reply to an audio message

1. Raise iPhone to your ear to play incoming audio messages.
2. Raise it again to reply.

To turn this feature on or off, go to Settings @ > Messages, then turn off Raise to Listen.

Share, save, print, copy, or delete a message or attachment

In a conversation, do any of the following with attachments:
e Share, save, or print an attachment: Tap the attachment, then tap (] .
e Copy an attachment: Touch and hold the attachment, then tap Copy.
e Share items from another app: In the other app, tap Share or ('], then tap Messages.

e Forward a message or attachment: Touch and hold a message or attachment, tap More, select
additional items if desired, then tap &> .
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e Delete a message or attachment: Touch and hold a message or attachment, tap More, select
additional items if desired, then tap i .

Note: Attachments you send over iMessage (such as photos or videos) may be uploaded to Apple and
encrypted so that no one but the sender and receiver can access them. To improve performance,
your device may automatically upload attachments to Apple while you are composing an iMessage. If
your message isn't sent, the attachments are deleted from the server after several days.

Send animated effects in Messages on iPhone

In the Messages app (J, you can animate a single message with a bubble effect or fill the entire
message screen with a full-screen effect (for example, balloons or confetti). You can even send a
personal message with invisible ink that remains blurred until the recipient swipes to reveal it.

You need iMessage to send and receive message effects. See About iMessage and SMS/MMS .

Send a handwritten message

Use your finger to write a message. The recipient sees the message animate, just as ink flows on
paper.

1. In a conversation, rotate iPhone to landscape orientation.
2. Tap @ on the keyboard.
3. Write a message with your finger or choose a saved message at the bottom, then tap Done.

4. Tap @ to send your message or @ to cancel.

Scroll to write a
longer message.

’1/\

ankﬁom

Aoy iy consriids g Lo N SorrY

Aullor UM

Choose a saved message.l Return to the|
Touch and hold to delete keyboard.
a saved message.

iPhone User Guide 263



Draft

After you create and send a handwritten message, the message is saved at the bottom of the

handwriting screen. To use the saved messages again, tap it. To delete the saved message, touch
and hold it until the messages jiggle, then tap &) .

Use a bubble effect

Use bubble effects to animate the message bubble.
1. In a new or existing conversation, type a message or insert a photo or Memoji.
2. Touch and hold @, then tap the gray dots to preview different bubble effects.

Tip: Want to send a personal message? When you use invisible ink, the message remains
blurred until the recipient swipes to reveal it.

3. Tap @ to send the message or @ to cancel.

Bubble

- Preview other
bubble effects.

SEND WITH INVISIBLE INK

i— Send

— Cancel

Use a full-screen effect

Use full-screen effects to animate the message screen.

1. In a new or existing conversation, type a message or insert a photo or Memaoji.

iPhone User Guide 264



Draft

2. Touch and hold @, then tap Screen.
3. Swipe left to preview different screen effects.

4. Tap @ to send the message or @ to cancel.

Happy anniversary — Send

— Swipe left or right
to preview other
screen effects.

Messages automatically uses the following screen effects for specific text strings:
e Balloons for “"Happy birthday”
¢ Confetti for “Congratulations”

¢ Fireworks for “Happy New Year”

Use iMessage apps in Messages on iPhone

In the Messages app (J, you can decorate a conversation with stickers, play a game, share songs,
and more—all through iMessage apps—without leaving Messages. You can expand your message
options by downloading more iMessage apps from the App Store.
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e

Gordon

Hey! Let’s run tomorrow!

Ok. What time should we
meet?

Bright and early! 6:00 am?

statue in the park?

{— Browse iMessage apps.

Browse and download iMessage apps

1. In a Messages conversation, tap € to open the iMessages App Store.

2. Tap an app to see more details and reviews, then tap the price to purchase an app or tap Get to
download a free app.

All purchases are made with the payment method associated with your Apple ID .

Use an iMessage app

1. In a conversation, tap an iMessage app in the app drawer.
2. Tap an item in the iMessage app to add it to a message bubble.

3. Add a comment if you want, then tap @ to send your message or @ to cancel.

Decorate with stickers

If you've downloaded a sticker app from the App Store, you can enhance your photos and videos with
stickers in Messages.

1. In a conversation, tap a sticker app in the app drawer.
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2. Touch and hold a sticker, then drag it on top of a message in the conversation. Before you release
it, you can do any of the following:

e Adjust the angle: Rotate a second finger around the finger dragging the sticker.
e Adjust the size: Move a second finger closer to or away from the finger dragging the sticker.
You can also place the sticker on top of another sticker, or on a photo.
To see text that's covered by a sticker, double-tap the sticker.

To see more information about the sticker, touch and hold the sticker, then tap Sticker Details. You
can do the following:

e See who sent the sticker.
¢ View the iMessage app that sent the sticker.

¢ Delete the sticker—swipe left, then tap Delete.

Manage iMessage apps
1. Tap ¢+ in the app drawer.

2. Tap Edit, then do any of the following with your iMessage apps:
e Reorder apps: Drag = .
e Add an app to your Favorites: Tap

e Remove an app from your Favorites: Tap @ .

Hide an app: Turn the app off.

Delete an app: Swipe left on the app, then tap Delete.

Use Animoji and Memoji in Messages on iPhone

Use the Messages app (J to express yourself with Animoji and personalized Memoji sticker packs that
match your personality and mood. On models with a TrueDepth camera , you can send animated
Animoji or Memoji messages that record your voice and mirror your facial expressions.

Create your own Memoji

You can design your own personalized Memoji—choose skin color and freckles, hairstyle and color,
facial features, headwear, glasses, and more. You can create multiple Memoji for different moods.
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1. In a conversation, tap @ , then tap + .

2. Tap each feature and choose the options you want. As you add features to your Memoji, your
character comes to life.

3. Tap Done to add the Memoji to your collection.

To edit, duplicate, or delete a Memoji, tap @ , tap the Memoji, then tap - .

Send Animoji and Memoiji stickers

Messages automatically generates sticker packs based on your Memoji and Animoji characters. You
can use stickers to express a range of emotions in new ways.

1. In a conversation, tap @ .
2. Tap a Memoiji or Animoji in the top row to view the stickers in the sticker pack.
3. To send a sticker do one of the following:

e Tap the sticker to add it to the message bubble. Add a comment if you want, then tap @ to
send.

e Touch and hold a sticker, then drag it on top of a message in the conversation. The sticker is
sent automatically when you add it to the message.
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Send animated Animoji or Memoji recordings

On supported models you can send Animoji and Memoji messages that use your voice and mirror your
facial expressions.

Mayur

Were you at work on Friday?

Yes. | thought you were, t00.
No?

1 was there part of the day.

Want to head down to the
beach this weekend?

Definitely! How about a picnic
on the beach?

(o (2 L)
+t 02O -

e

1. In a conversation, tap €, then choose an Animoji or Memoji.

2. Tap @ to record your facial expressions and voice. Tap the red square to stop recording.
Tap Replay to review your message.

3. Tap © to send your message or @ to cancel.

You can also take a picture or video of yourself as an Animoji or Memoji, decorate it with stickers,
then send it; see Add camera effects to a photo or video . Or you can become an Animoji or Memoji in
a FaceTime conversation.

Send a Digital Touch effect in Messages on iPhone

In an iMessage conversation in the Messages app (J, you can use Digital Touch to send animated
sketches, taps, kisses, heartbeats, and more. You can even add a Digital Touch effect to a photo or
video.
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Send a sketch
1. Tap @ in the app drawer.
2. Tap the color dot to choose a color, then draw with one finger.
You can change the color, then start drawing again.

3. Tap @ to send your message, or tap @ to delete it.

Express your feelings
1. Tap @ in the app drawer.

2. Send one of the following animations using gestures on the canvas. Your feelings are sent
automatically when you finish the gesture:

e Tap: Tap with one finger to create a burst of color. You can change the color, then tap again.

e Fireball: Touch and hold with one finger.

Kiss: Tap with two fingers.
e Heartbeat: Touch and hold with two fingers.

e Heartbreak: Touch and hold with two fingers until you see a heartbeat, then drag down to
break the heart.

Note: If you have Apple Watch or another sensor that records heartbeat data, Messages may use
the recorded data when you send a Digital Touch heartbeat.

Add a Digital Touch effect to a photo or video
1. Tap @ in the app drawer.

2. Tap @ .
3. Tap O to take a photo or @ to record a video.
4. Add a Digital Touch effect, such as a sketch or kiss.

5. Tap @ to send your message, or tap €3 to delete it.

Send and receive money with Apple Pay on iPhone (U.S. only)

In the Messages app (J, you can use Apple Pay to send and receive money quickly and easily.
There's no app to download, and you can use the cards you already have with Apple Pay.
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When you receive money in Messages, it's added to your Apple Cash card in Wallet. See Set up and
use Apple Cash on iPhone (U.S. only) .

I'm back in town.

Great! Going to spin class
tomorrow?

Definitely. Sign us up for
another session?

— Tap to preset
No problem. It's $45 for each this amount.
of us.
(O ) i)
+ O2edDcec O -

Request

Note: Before you send or receive payments with Apple Pay, you need to agree to the terms and
conditions of this service.

Send a payment in Messages

@ Ask Siri. Say something like: “Apple Pay 75 dollars to Phillip for the zipline tour” or “Send 15
dollars to Kim for lunch with Apple Pay.” Learn how to ask Siri .

You can also do the following:
1. In an iMessage conversation, tap @ , then enter the amount.

Tip: If there's an underlined monetary amount in a message, tap it to preset the payment.
2. Tap Pay, add a comment if you want, then tap @ .

3. Review the payment information. If you don't have sufficient funds in Apple Cash, you can pay the
balance using your debit card in Wallet.

4. Authenticate the payment with Face ID, Touch ID, or your passcode.
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You can cancel a payment that hasn't been accepted. Tap the payment bubble, then tap Cancel
Payment.

Request a payment

@ Ask Siri. Say something like: “Ask Kim for 26 dollars with Apple Pay.” Learn how to ask Siri .
You can also do the following:
1. In an iMessage conversation, tap @ .

2. Enter the amount, then tap Request.

Apple Cash and sending and receiving payments through Apple Pay are services provided by Green Dot Bank, member FDIC.

Change message notifications on iPhone

In Settings @ , you can set up and manage message notifications for the Messages app (J and filter
unknown senders.

Manage notifications for messages

1. Go to Settings @ > Notifications > Messages.
2. Choose options, including the following:
e Turn Allow Notifications on or off.
e Set the position and locations of message notifications.
e Choose the alert sound for message notifications.
e Choose when message previews should appear.

See View and respond to notifications on iPhone .

Set the alert sound for messages

1. Go to Settings @ > Sounds & Haptics (on supported models ) or Sounds (other models).
2. Tap Text Tone, then do one of the following:

e Tap Vibration, then choose an option.

e Tap a sound below Alert Tones.

e Tap Tone Store to download an alert sound from the iTunes Store.
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See Change iPhone sounds and vibrations .

Assign a different ringtone to a contact

1. Open Contacts, then select a contact.
2. Tap Edit, then tap Text Tone.
3. Choose an option below Alert Tones.

To allow alerts for messages sent by this contact even when Do Not Disturb is on, turn on
Emergency Bypass.

Mute notifications for a conversation

1. In the Messages list, swipe left on the conversation.

2. Tap Hide Alerts.

Filter and block messages on iPhone

In the Messages app (J, you can filter messages from unknown senders and block unwanted
messages.

Filter iMessage messages from unknown senders
1. Go to Settings @ > Messages.

2. Turn on Filter Unknown Senders.

This turns off iMessage notifications from senders who aren’t in your contacts and sorts the
messages into the Unknown Senders tab in the Messages list.

You can’t open any links in a message from an unknown sender until you add the sender to your
contacts or reply to the message. If the message is spam, tap Report Junk (below the message) to
delete and send the message to Apple.

Block messages from a specific person or number

1. In a Messages conversation, tap the name or number at the top of the conversation, then tap ¢ at
the top right.

2. Tap the name or phone number to view the contact card.

3. Scroll down, then tap Block this Caller.
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To view and manage your list of blocked phone numbers and contacts, go to Settings @ > Messages
> Blocked Contacts. See the Apple Support article Block phone numbers, contacts, and emails on
your iPhone, iPad, or iPod touch .

Delete messages on iPhone

In the Messages app (J, you can delete messages and entire conversations.

Delete a message

1. Touch and hold a message bubble, then tap More.

2. Select the message bubbles you want to delete, then tap i .

Delete a conversation

1. In the Messages list, swipe left on the conversation.
2. Tap Delete.

With Messages in iCloud, conversations you delete from iPhone are also deleted from your other
Apple devices where Messages in iCloud is turned on. See Use Messages in iCloud .

Note: You can’t recover a deleted conversation.

Music

Get music on iPhone

Use the Music app 7 to enjoy music stored on iPhone as well as music streamed over the Internet.
With an optional Apple Music subscription, you can listen to millions of songs ad-free and discover
music together with friends.

WARNING: For important information about avoiding hearing loss, see Important safety information
for iPhone .

Get music to play on iPhone in the following ways:
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e Become an Apple Music subscriber: With a subscription and a Wi-Fi or cellular connection, stream
as much music as you like from the Apple Music catalog and your Music library. You can download
songs, albums, and playlists, and share music with your friends. See Subscribe to Apple Music on
iPhone .

Note: You need a Wi-Fi or cellular connection to stream music. Services and features aren’t
available in all countries or regions, and features may vary by region. Additional charges may
apply when using a cellular connection.

e Participate in Family Sharing: Purchase an Apple Music Family membership, and everyone in your
Family Sharing group can enjoy Apple Music. See Use a shared Apple Music family membership .

e Purchase music from the iTunes Store: See Get music, movies, TV shows, and more in the iTunes
Store on iPhone .

e Sync music with Music (macOS Catalina) or iTunes (macQOS 10.14 and earlier and Windows PCs)
on your computer: See Sync iPhone with your computer .

o Ljsten to Beats 1: Beats 1is a worldwide radio station broadcasting live on Apple Music. No
subscription is required to listen to Beats 1.

View albums, playlists, and more in Music on iPhone

In the Music app ~ , the library includes music you added or downloaded from Apple Music, music
and videos you synced to iPhone, TV shows and movies you added from Apple Music, and your
iTunes Store purchases.
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— Tap to view additional
categories.

Library
Playlists
Artists
Albums

Songs

Recently Added

b
9N

balloons don't float h. Lover

e Bl =7

#  YouNeedToCalmD.. n » -|~ Player

B © J @& Q

Browse and play your music

1. In the Music app, tap Library, then tap a category, such as Albums or Songs; tap Downloaded
Music to view only music stored on iPhone.

2. Tap an item, then tap Play, or tap Shuffle to shuffle an album or playlist.
You can also touch and hold the album art, then tap Play.

To add other categories to the library, tap Edit, then select additional categories, such as Genres and
Compilations.

Sort your music
1. Tap Library, then tap Playlists, Aloums, Songs, TV & Movies, or Music Videos.

2. Tap Sort, then choose a sorting method, such as title, artist, or recently added.

Play music shared on a nearby computer

If a computer on your network shares music through Home Sharing, you can stream its music to your
iPhone.
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1. On your iPhone, go to Settings @ > Music, tap Sign In below Home Sharing, then sign in with your

Apple ID.

2. Open the Music app 7 , go to Library > Home Sharing, then choose a shared library.

Remove Apple Music songs from iPhone

Go to Settings @ > Music, then turn off Sync Library.

The songs are removed from iPhone but remain in iCloud. Music you purchased or synced also

remains.

Play music on iPhone

Use Now Playing in the Music app 7 to show lyrics and play, pause, skip, shuffle, and repeat songs.

Control playback

Tap the player near the bottom of the screen to show the Now Playing screen, where you can use

these controls:

Control
>
il

>

iPhone User Guide

Description
Play the current song.

Pause playback.

Skip to the next song. Touch and hold to fast-forward through the current song.

Return to the song’s beginning. Tap again to play the previous song in an album or playlist.
Touch and hold to rewind through the current song.

Hide the Now Playing Screen button.
Tap for more options.

Show time-synced lyrics (lyrics not available for all songs).

Stream music to Bluetooth or AirPlay-enabled devices.

See the Playing Next queue.
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- Tap to hide Now Playing.

You Need To Calm Down
Taylor Swift

i— Playhead

Drag to adjust volume.

Adjust the volume, see song details, and more

The Now Playing screen contains additional options for controlling and accessing music.
¢ Adjust volume: Drag the volume slider.
You can also use the volume buttons on the side of iPhone.

¢ Navigate to the artist, album, or playlist: Tap the artist name below the song title, then choose to
go to the artist, album, or playlist.

e Scrub to any point in a song: Drag the playhead.

See time-synced lyrics

You can see time-synced lyrics for many songs in Apple Music.
1. Tap the player to open Now Playing.

2. Tap G2 to show lyrics that scroll in time with the music.

3. Tap GJ again to return to Now Playing.

To see all of a song’s lyrics, tap **+, then tap View Full Lyrics.
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Note: You need an Apple Music subscription to view lyrics.

Use the Playing Next queue
1. Tap the player to open Now Playing.

2. Tap:=, then tap a song to play it and the songs that follow.
To reorder the list, drag =.
3. Tap:= again to return to Now Playing.

To add music and videos to the Playing Next queue when browsing or playing music, touch and hold
the song, album, playlist, or video, then tap Play Next to play the music or video right after the
currently playing item. Tap Play Last to add the item to the end of the queue.

Tip: If you're using HomePod to stream music and your friends are on the same Wi-Fi network,
they can add and reorder items in the Playing Next queue. To learn more about HomePod speaker
access, see the HomePod User Guide .

See what you recently played
1. Tap the player to open Now Playing.

2. Tap:=, then swipe down to see the playing history.

Tap a song in the history to play it. Tap Clear to remove your playing history.

Get audio controls from the Lock screen or when using another app

Open Control Center , then tap the audio card.

Stream music to Bluetooth or AirPlay-enabled devices
1. Tap the player to open Now Playing.

2. Tap . , then choose a device.
See Play audio from iPhone on HomePod and other wireless speakers .

Note: You can play the same music on multiple AirPlay 2-enabled devices, such as two or more
HomePod speakers. You can also pair two sets of AirPods to one iPhone and enjoy the same song or
movie along with a friend. See Control audio on multiple AirPlay 2-enabled devices and Share audio
with AirPods and Beats headphones .
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Listen to broadcast radio on iPhone
You can play thousands of broadcast radio stations on iPhone.
e Ask Siri: Summon Siri , then say something like, “Play Wild 94.9" or “Tune in to ESPN Radio.”

e Search for a station: Tap Search, enter the station in the search field, then tap a result to play the
station.

You can search for stations by name, call sign, frequency, and nickname.

e Choose a station in the Radio tab: Tap Radio, swipe up, then choose a station below the Broadcast
Radio heading.

Note: You don't need a subscription to Apple Music to listen to broadcast radio. Broadcast radio isn't
available in all countries or regions and not all stations are available in all countries or regions.

Apple Music

Subscribe to Apple Music on iPhone

Apple Music is an ad-free streaming music service that lets you listen to millions of songs and your
music library. As a subscriber, you can listen any time—online or off—and create your own playlists,
get personalized recommendations, see music your friends are listening to, watch exclusive video
content, and more.

Note: Apple Music features may vary by country or region. Learn what's available in your country or
region .

Join Apple Music

Join Apple Music when you first open the Music app 7 ; to join later, go to Settings @ > Music, then
tap Start Free Trial. There are three subscription plans:

¢ Individual subscription: Get access to the full Apple Music catalog, expert recommendations, and
on-demand radio stations.

e Family subscription: Up to six people can enjoy unlimited access to Apple Music on their devices.
e Student subscription: Have complete access to Apple Music, at a price designed for students.

If you're a student at a qualifying school, you can join Apple Music for a discounted subscription
price for up to 48 months (4 years). The time needn’t be continuous. Student subscriptions aren’t
available in all locations (see where they're available ).

New subscribers can start a trial and cancel at any time. If you end your Apple Music subscription,
you can no longer stream Apple Music songs or play Apple Music songs you downloaded.
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